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UNIT 2: DATABASE 2 
 

INTRODUCTION 

Welcome to Database 2.  In this Unit you will learn more about database and its objects such 
as Forms and Tables which were discussed previously in your Database 1. In depth knowledge 
of designing and formatting these objects will be featured. Furthermore, two remaining 
objects will be discussed, namely, Queries and Reports. The importance of each object will be 
elaborated for better understanding for you to be able to create a well-designed and useful 
database. 

Take note that activities are found at the end of every module lesson and summative 
exercises after every topic. All answers to activities are found after the summative exercises. 
 
The following icons are used in this module: 
 
   

  Student Aims      Student Activity 

 

  Time Frame      Note 

         

  Practical Student Activity  Answers to Learning Activities 

 
 

Objectives or aims 
 

On successful completion of this module, students will be able to: 

 improve computer skills to create a useful database 

 manage data with tables and forms 

 accomplish output with the use of reports and queries 
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         Time Frame 
 
This unit should be completed within 10 weeks. 

If you set an average of 3 hours per day, you should be able to complete the unit comfortably 
by the end of the assigned week. 
Try to do all the learning activities and compare your answers with the ones provided at the 
end of the unit. If you do not get a particular exercise right in the first attempt, you should not 
get discouraged but instead, go back and attempt it again. If you still do not get it right after 
several attempts then you should seek help from your friend or your tutor. Do not pass any 
question without solving it first. 
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12.2.1  Getting Started 

12.2.1.1  Understanding How Database Works 

In Unit 4, Lesson 1 of your Database 1, we were able to define Database as a collection of data 
and a means to manipulate data in a useful way. Database must provide proper storage for 
large amounts of data, easy and fast access and facilitate the processing of data. You may be 
unaware but most of the time you are using databases. Some of the common databases might 
be: 

 Address book 

 Library catalogue 

 Telephone directory 

 Stock list 

Often abbreviated DB, a database must organise the collected information in such a way that 
a “computer program” can quickly select desired pieces of data. You can think of a database 
as an electronic filing system. 

Computer database are those data or information stored in the computer. To arrange and 
organise records, computer databases rely on database software or program. Database 
software allows the user to collect, edit, delete and organise information so that they can be 
easily managed, updated and accessed by the user.   

Database software is a software application used by the user (like you and me) to manage. 
Management and retrieval queries database is called the database management system. 
There is a number of database software that are available. Examples of commonly used 
database software are: 

 DB2 

 Microsoft SQL Server 

 Oracle 

 Sybase 

 Interbase 

 Xbase 

 MySQL 

 dBaseIII 
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 FoxPro 

 (Microsoft)Access  

Uses of Database System 
The advantages of using database are considerable. Without them, you would be hard-
pressed to find a decent system of keeping and managing information. In recent years, the 
increased flexibility and user-friendliness of databases make these systems a crucial business 
component.   

Databases are intended for storing and maintaining large amounts of information. The 
following is a list of examples of information that can be sorted and kept in a database: 

 School enrolees 

 Inventory 

 Payroll 

 Personal records 

 Music collection catalogue 

 Phone and address list 

Why use a database? 

 It can store very large numbers of records efficiently 

 It is very quick and easy to find information 

 It is easy to add new data and to edit or delete old data 

 Data can be searched easily 

 Data can be sorted easily 

 Data can be imported into other applications 

 More than one person can access the same database at the same time 

 It is more secured compared to paper files. 

Database Functions 
The development of database technology is currently growing rapidly, many of the forms 
which were used only as a storage area consisting of field and records. It will then display the 
information in various formats with a simple display, then the simple form will be then 
obtained to display a database that is useful to analyse the data for a particular purpose. By 
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leveraging existing relational database then obtain a way to anticipate the need to analyse 
data quickly to help get a decision in an application or organisation. 

The database provides a facility or ease in producing information that is used by users to 
support decision-making.   

Here are some functions of database applications: 

 Bank – customer data management, accounting, all banking transactions 

 Airport – reservation data management, scheduling 

 Universities – Management of registration, alumni 

 Sales – Management of customer data, product, sales 

 Factory – Management of production data, inventory, ordering, agent 

 Personnel – Management of employee data, payroll, tax 

 Telecommunications – management of billing data, number of pulses 

Traditional database is organised by fields, records, and files. We will further discuss this topic 
in the upcoming lessons. To access information from a database, you need a database 
management system (DBMS). This is a collection of programs that enables you to enter, 
organise, and select data in a database. 

There are many functions of a database that are key components to the operation of 
database management. There are five standard functions of database management and they 
are: 

1. Ability to update and retrieve data 
 This is the fundamental component of database management and essential to database.  

Without the ability to view or manipulate data, there would be no point of using a 
database system. Updating data in a database includes adding new records, deleting 
existing records and changing information within the record.   

2. Support concurrent updates 
 Concurrent updates occur when multiple users make updates to the database 

simultaneously. Supporting concurrent updates is also crucial to database management 
as this component ensures that updates are made correctly and the end result is 
accurate. 

3. Recovery of data 
 In the event if a catastrophe occurs, database management must provide ways to 

recover a database so that data is not permanently lost. There are times a computer 
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may crash, a fire or other natural disaster may occur, or a user may enter incorrect 
information invalidating or making records inconsistent. 

 If the database is destroyed or damaged in any way, the database system must be able 
to recover the correct state of the database: this process is called Recovery. 

4. Security 
 Security is the prevention of unauthorised users accessing the database. Database 

system uses features such as encryption, authentication, authorisation and views to 
provide security to the database. 

5. Data integrity 
 Data integrity is an important function of database management. This is a set of rules 

applied to avoid incorrect or inconsistent data. It ensures the quality of the data in the 
database. 

              Student Activity 12.2.1.1 

Answer the following. 

1. What is Database? 
  

  

  

  

2. What is Database software? 
  

  

  

3. List down 4 examples of database software? 
  

  

  

  

4. What are the functions of database application in the following: 
 

 Bank-  ____________________________________________________ 

 University -___________________________________________________________ 

 Sales -_______________________________________________________________ 

 Personnel -___________________________________________________________ 
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12.2.1.2  Getting Familiar With Database Screen 

Microsoft Access is an information management tool that helps you store information for 
reference, reporting and analysis. It is a program that can create, format, save, maintain, 
retrieve and analyse volumes of related information or data in a format known as a database.  
Microsoft Access can store thousands of data which you can quickly search and sort. The way 
Access organises database is similar to the way Excel organises worksheets within a 
workbook. 

Functions and Uses of MS Access 

There is a need for a database management tool like Access for all corporate and private 
organisations where large amount of data is being handled. When large amounts of data is 
being saved and processed the name “Database” is used. Database Management as discussed 
in Lesson 1, is the process of manipulating stored data. Databases are designed to offer an 
organised mechanism for storing, managing, and retrieving information. Basically, database 
management involves the function of data storage and retrieval. In some cases, data stored in 
a database may be edited and manipulated according to the required needs of a certain 
individual, group or company. 

MS Access has very easy operating procedure compared to other database management tools 
that are available. Besides it is fairly cheap and can be installed in most computers and it 
provides an excellent graphical user interface (GUI), whereas most database management 
tools provide console operating interface (CUI). This feature creates an excellent User-friendly 
environment.  

Table creation for database management is easily done here. Direct interaction with tables 
created and editing are possible which leads to easy operation whereas other database 
management software needs complex syntaxes in creating these. There is no need for the 
user to have high programming knowledge in using MS Access. 

Access is a flexible and relatively simple way to create database to store, manage and enter 
data.  It offers simple, yet a robust way to manage your data. 

In your Database 1, you have learned how to launch or start the MS Access program.  
However, we need to take some time to allow you to familiarise yourself once more with the 
Access environment. 

The Access Program Window 
You can open MS Access 2010 by doing the following steps: 

1. Click the Start  button. 

2. Point your mouse to All Programs. 
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3. Point to Microsoft Office. 

 
4. Click on Microsoft Office Access 2010. 

 
Once opened, you will see the following on the Access program window: 

 
 

5. Click Blank database. 

6. Finally, click Create. 

Quick Access  

File Tab  

 Tabs  

 Templates 

 Preview 

Click Microsoft Office 

Access. 
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Now, you can see the Access working interface, where you can start creating your database. 
MS Access Interface. 

 

 
 
MS Access 2010 contains ribbons, tabs, commands which are organised into groups, status 
bar, views, navigation pane and quick access toolbar. The ribbon and quick access toolbar can 
be customised to suit your need. 

Whenever you are learning a new program or updating yourself with new versions of the 
programs you already know, it is important to familiarise yourself with the program windows 
and the tools within it. Familiarising yourself with the tools will ease your work and help you 
maximise the uses of these different tools available and actual purpose of these application 
programs. 

Let us now navigate and know the parts of the Access window. 

1. The Quick Access Toolbar is located above the Ribbon.  It 
lets you access common commands no matter which tab 
you have selected in the Ribbon. By default, it shows the 
Save, Undo, and Redo commands. By clicking the drop-

 Quick Access 

Ribbon 

Navigation 
Pane 

Document 
Tabs Bar 

Record 
Navigation 
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down arrow you can add additional commands to the toolbar. 

2. The Ribbon is the panel at the top portion of the document. It has six tabs:  Home, 
Create, External Data, Database Tools, Fields and Table. These tabs contain commands 
and tools which are grouped according to their function. 

 Tabs – represents the activities you perform and contain related groups. 

 Groups – organise related commands. Group name appears below the group ribbon. 

 Commands – appear within each group. 

 
 
 
 
 

Moving the mouse pointer over each command or tool will display the name and function of 
the command tool. 

When you launch MS Access 2010, the Ribbon is displayed. You can hide or display the Ribbon 

by clicking Minimise the Ribbon or Expand the Ribbon . To Display the full ribbon, click 
the tab or press Ctrl+F1. You can also minimise the displayed ribbon by double clicking the 
tab. The appearance of the commands on the Ribbon may change depending on its width. A 
command may appear as a large or a small button. 

 
 
 
 
 
 
 
3. The Navigation Pane allows you to view and manage your database objects. These 

objects are grouped according to its type such as tables, queries, reports and forms. To 
open an object, simply point the mouse to the object name and double-click it. You can 
display or hide the navigation pane by clicking the Shutter Bar button. 

 
 

 

Click a tab to see 
more commands. 

Each tab is divided into 
groups of commands. 

Click the arrow to see 
more commands. 

Click to hide or unhide 
the Ribbon. 
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4. Document Tabs Bar.  All open objects are displayed on the Document Tabs bar. To view 

an object, click on its tab. Each tab represents an open object, and is marked with an 
icon to show what type of object it is. 

 
 
 
 
 
 
 

5. The Record Navigation bar allows you to navigate through records one at a time. You 
can click the arrows to navigate through the records. You can jump to a specific record 
by typing its Identification Card (ID) into the white box. 

 
 
 
 
 
 
 
You can use the record search box to search for any term in the current open object. The first 
result that matches your search term will appear highlighted with a yellow border. To 
navigate through additional results, press the Enter key. 

The Backstage view gives you various options for opening, saving, printing, and viewing more 
information about your database.  It is similar to the Office Button Menu from Access 2007 or 
the File menu from earlier versions of Access. However, unlike those menus, it is a full-page 
view, which makes it easier to work with. 

  

Shutter Bar button 

Objects 

The current tab 

appears in bold 

letters. 

Click the X to 

close the current 

tab. 

Click the arrow 

to see more 

open tabs. 

Record Search 

Box 
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 Follow the given steps to open the Backstage. 

1. Click the File tab. 

2. You can choose an option on the left side of the page. 

3. To get back to your database objects, just click any tab on the Ribbon. 

Below is the sample screen of the Backstage view. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
1. Save, Open, and Close 
 Various commands that let you Save, Open, and Close objects and databases are now 

found in Backstage view. Remember that command Save saves only the current object, 
not the entire database. 

2. Info 
 It contains information about your database. It also contains options that let you 

Compact and Repairs your database to fix file problems and Encrypt it with password.  

3. Recently Opened 
 The last four databases opened are displayed here for easy access. 

4. New 
 From the New pane, you can create a new database from scratch, or you can choose 

from a selection of templates. 

5. Print 
 The Print pane, contains options for printing the current object in your database. 

6. Save and Publish 
 This pane provides advanced options for saving your database. 

The Backstage View 
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7. Help 
 This pane is use to access Microsoft Office Help or check updates to your software. 

8. Option 
This is where you can change various Access options. For instance, you can choose a 
form to automatically display when your database is opened or modify the default font 
style. 

                Student Activity 12.2.1.2 

1. Write down the MS Access screen part that matches each given description. 
 

PARTS DESCRIPTION 

1. Tab that displays all the open objects in your database. 

2. This element allows you to navigate through records one at a time. 

3. This pane allows you to view and manage your database objects. 

4. 
This element lets you access common commands no matter which tab 
you have selected in the Ribbon. 

5. This is the panel at the top portion of the document. 

 
2. Name the parts of the Access program Window. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

A 

B 

C 

D 

E 
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A. ____________________________________ 

B. ____________________________________ 

C. ____________________________________ 

D. ___________________________________ 

E. ____________________________________ 
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12.2.1.3  Getting Help and Maintenance 

Getting Help 

One of the best features of any MS Office programs is the Help menu. Help is available in 
many ways in MS Access. You can even get help from the Help        button through the 
internet or just right in your computer as you work. 

 

 

In various sections of our lessons, we will use some objects that you may not be familiar with.  
Fortunately, to get help for these unfamiliar items, click it and press F1. The Help window 
would come up and would display one or more options on the topic you have clicked. If you 
see a link with the same name of the item you clicked, you can click that link and its 
explanation will be displayed. Help can also be access in the Backstage View. You have learned 
from Lesson 2, Backstage can be viewed once you click the File Tab. 

 

 

 

The Access Help Window 

Access Help Button 
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The Roles and Ways to use help menu to troubleshoot MS Access 

1.   Help to solve problems 

2.  Simple and relevant 

3.  Ways to use menu 

Helps to Solve Problems 
Help menu in MS Access will help users to understand the primary mechanism itself.  As the 
help menu is composed of different types of content so as to assist user when they are unable 
to complete a task it needs to understand the concept in detail.  Users first make use of the 
help menu so as to solve their problem. 

Simple and Relevant 
The interface of the help menu is simple, efficient and relevant it enables users to get help 
easily and return to their tasks efficiently.  The help menu will first encounter problems in 
your program and then it will solve the problem by incorporating fundamental assistance to 
the user interface directly, thereby creating clear and consistent entry points. 

Ways to use Help Menu 
Access offers number of assistance and provides topic and index entries built in language 
technology of MS Access that will allow you to get assistance.  These are also integrated into 
some wizards like Web Page Wizard, which will guide you to common tasks and offer more 
flexibility. 

 

 

 

Access 

Help 
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StudentPractical Activity   

 

Before doing this activity make sure you open your MS Access and that you have created a 
blank database.  At this point let us use the Office Assistant.  

1. Press F1. 

 

 

 

 

2. In the Access Help window and on the left side of Search, type Create Table. 

3. Click Search.  

4. On the list that appears, click Create tables in a database. 

5. On the Access Help window that appears, read the text, scroll down, and click Create 
New Table. 

6. After reading it, on the toolbar of the Access Help window, click the Back button. 

7. Close the Access Help window. 

  Student Activity 12.2.1.3   

Answer the following. 

1. What is the role of help menu in Access? 
  

  

  

  

2. In your own words, discuss the roles and ways to use the Help Menu. 
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12.2.1.4  Working with Database Objects 

Before we continue with the database objects, let us recall what Relational Database is. From 
Database 1, you have learned that Relational database is a collection of tables, forms, reports 
and queries all organised by a program. By this point, you should already understand that a 
database is a collection of data organised into many connected lists.  

Databases in Access 2010 are composed of these four objects:   

a. tables 

b. queries 

c. forms 

d. reports 

Together, these objects allow you to enter, store, analyse and compile your data as you wish. 

A.   Table 
 All database objects rely on the existence of a database table. A table contains grids of 
 rows and columns that contain your data about a specific topic, such as name of 
 products or name of persons. Tables organise data into vertical columns which are 
 called fields and horizontal rows which are called records. 

 A field is more than just a column; it is a way of organising information by the type of 
 data it is.  Every piece of information within the field is of the same type. 

  

 Likewise, a record is more than just a row; it is a unit of information.  Every cell in a 
 given row is part of that row’s record. 

 All data is stored on tables and each of the objects that the database manages is linked 
 so this would make it easy for user to make adjustments to their files. Tables are good 
 for storing closely related information.   

 

Field 

Record 
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B.   Queries 
 A query allows you to work with a specific set of records that meet the criteria you have 
 specified from a table in the database. You can use queries to view, change and analyse 
 data in different ways. When you run a query, the results will appear in the Datasheet 
 view, shown like a table. 

 

 

 

 

 

 

 

 

 

 Queries are a way of searching for and compiling data from one or more tables. When 
 you build a query in Access, you are defining specific search conditions to find exactly 
 the data you want. 

C.   Forms 
 A form is a type of database object that is 
 used to enter, change, delete and display 
 data in a database. A form can contain 
 lines, colour and images together with 
 check boxes, button and other features 
 called controls. Access can create six basic 
 types of forms. The reason forms are used 
 so often is that it is an easy way to guide 
 people into entering data correctly. When 
 you enter data information into a form in 
 Access, the data goes exactly where the 
 database designer wants it to go – into one or more related tables. 

 Forms make entering data easier.  Using forms, it is possible to enter data into multiple 
 tables at once, all in one place. Forms help keep data consistent and well-organised, 
 which is essential for an accurate and powerful database. 
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D.  Reports 
 Reports allow you to present, organise, summarise and print all or part of the data in a 
 database. You can use the design tools to bring together data, charts, illustrations, 
 audios and videos. Reports are useful because they allow you to present components of 
 your database in an easy-to-read format. You can also customize and enhance your 
 report with colours and use various fonts to make it visually appealing.  Access offers 
 you the ability to create a report from table or query. 

 Tables, queries, forms and reports are the framework for any database you create in 
 Access.  Understanding how each of these objects works will help you create a database 
 that will be useful and help you retrieve the information you need. Even if you have a 
 good idea of how each object can be used, it can initially be difficult to understand how 
 they all work together.  It helps to remember that they all work with the same data. 
 Every piece of data that a query, form, or report uses are stored in one of your database 
 table. 

                 Student Activity 12.2.1.4 

1.  Define each object used in creating a database. 

a. Table 
  

  

 __________________________________________________________________

_____________________________________________________________________ 

b. Form 
  

  

  

c. Query 
  

  

 __________________________________________________________________ 

d. Report 
 
  

 _ 

 _

_____________________________________________________________________ 
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2.  Name the following objects. 

   

 

 

 

 

  

a. ____________________________ 
  b.  __________________________ 

 

 

c. ____________________________   d.  __________________________ 
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12.2.1.5  Planning a Database 

The first step in creating database is creating a plan that serves both as a guide to be used 
when implementing database and as functional specification for the database after it has 
been implemented. A database can be relatively simple and designed for use by a single 
person, or it can be large and complex and designed, for example, to handle all the banking 
transactions for thousands of clients. In the first case, the database design may be slightly 
more than a few notes on some scratch paper. In the latter case, the design may be a formal 
document hundreds of pages long that contains every possible detail about the database. In 
this unit, we will only create simple database to be used by a single person. 

In planning the database, regardless of its size and complexity, use the following basic steps: 

1. Collect and organise data. 
The data you will be collecting is what will make up the contents of the database. 
Without the data there will be no database. 

Data can be collected either manually or electronically. Collecting data manually means 
that the data is collected from surveys, questionnaires and interviews. Collecting data 
electronically means that data is collected through the use of computers through 
surveys on the internet, questionnaires being emailed to you, or any other electronic 
databases, and so on. 

When collecting data, make sure you get all the data that you think is needed for the 
database. Keep in mind that we want to keep record of information in a more organised 
layout. For example, you can get the class list at the administration office, or if you are 
doing inventory database for a shop, then you have to go around each item on the 
shelves, look at the prices, and write them down. That is how you collect data. 

2. Organise and update data. 
Once you have collected and gathered all your data, go ahead and arrange the data by 
grouping and classifying them according to any criteria. An example would be: 

 Greece 

 Brazil 

 Rome 

 Papua New Guinea 

These are classified as Countries. 

Examples of classifications would be according to: 

 Age 

 Grade Level 
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 Gender 

 Height 

 Nationality 

After arranging you also need to check to see which ones you need, and which ones 
need updating and correcting e.g.: spelling of words, grammar, punctuation, and so on. 
Organise and prioritise them and get them ready for you to enter them into the 
computer. 

3. Do a draft of the Form and Report. 
Design how you want your Forms and Reports to look like on paper. This makes it easier 
for you to construct the Forms and Reports on the computer. You can design by 
sketching it out and you do not need to be an artist. Make sure that the sketch is clear 
and easy to follow and information displayed on each of the sketches is clearly written. 
Border lines also need to be included in the sketches. 

Designing a Database 
Before creating a database, make sure that your database is well designed and well planned 
to ensure that it can be used for a long time. 

1. Define the purpose of your database. Consider the questions or queries you may want to 
answer about the stored data. 

2. Determine the tables that you need in the database. 

3. Determine the fields that you need in the database. 

4. Identify unique field values that will allow Access to connect information stored in a 
separate table. 

5. Determine the relationships between tables. A relationship works by matching data in the 
key fields which is usually a field with the same name in both tables. 

6. Test the design by entering the sample data. Check that you can run a query on the 
database and get the information you want. 

Characteristics of a Well-Designed Database 
1. Modifying data is easy. Changes to the value of one field within the table should not affect 

the values of the fields in the table. 

2. Retrieving information is easy. Extracting desired information from tables with well-
defined relationships should make accessing and retrieving data a lot faster. 
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3. Developing and building user application is easy. Data manipulation would be the main 
focus of programming and not solving problems associated with a poorly designed 
database. 

4. Maintaining the structure is easy. Changes made to any table or columns should not affect 
other tables or columns. 

5. Adding and deleting data is easy. 

Many database designers fall into the trap of designing a database based on the database 
program tools instead of designing it based on the needs of the organisation. The database 
may suffer from poor data integrity, insufficient structural design and inconsistent data. The 
database program is just a tool to achieve the objectives of the database. 

 

            Student Activity 12.2.1.5 

Design a database. Apply the steps on how to plan a database from this lesson. Write your 
sample draft of your form on the space provided.  You may choose one (1) from the 
following: 

A.  Phone Directory of family members, friends and colleagues. 

B.  Music Table (e.g. Rock, alternative, reggae). 

C.  Pastries in a bakeshop or bakery. 
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Use this space below to write down your designed database. 
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12.2.1.6  Exiting Access 

Exiting files in Access is simply the same approach you use for other Office Applications, such 
as Word, Excel, and PowerPoint. With Access, a single database has coverage of Tables, 
Forms, Queries, and Reports; therefore you must be careful when exiting Access. Always 
remember to save your work before closing. 

Exiting Objects/ Files 
Exiting Objects or Files in the Access does not mean that you close the whole application but 
just a certain object in the database that populated your screen. It is better that you keep 
your screen organise by closing the objects (table or form) that you are not using at the 
moment. Follow the steps below on how to exit Objects. 

1. Click on the CLOSE           Button on the right-most of the Object window to close/ exit. 

2. Alternatively, right-click on the Object Window Tab    ( contains the name of 

the object) and select Close. 

Exiting Access 
The above steps exit the objects in Access but not the application itself. Like all other 
applications, the approach/ methods used to close/ exit is just similar. 

1. Click on the Close Button, usually on the upper right-most corner of the window, to 
close Access. 

2. Or, click on File Tab  Exit. 

 
 
 

 

 

 

 

 

 

              Student Activity 12.2.1.6 

 
Answer the following. 

1. List down the 2 ways in which you can exit MS Access. 

File Tab 

Exit 
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a.            

b.            

 

2. Draw the button that allows you to close MS Access. 
 

        

3. What is the importance of closing unused tables or forms while working on your 
database? 
_______________________________________________________________ 

_______________________________________________________________ 

_______________________________________________________________ 

 

Summative Activity 12.2.1 
 

Answer the following. 

1. Put a check mark if the statement is correct and a cross mark if not. 

_____ a.  One of the best features of any MS Office programs is the Help Menu. 

_____ b.  Help is available in many ways in MS Access. 

_____ c. You can get Help from                button.    

_____ d.  We cannot get Help from internet. 

_____ e.  Backstage view also offers Help menu. 

_____ f.  F12 is the function key for Help. 

2. List three ways how you can get help in MS Access Program. 

  

  

  

3.   Identify the term being described by the following statement. 

_______________ a.  An Object that is useful because it allows you to present components of 
your database in an easy-to-read format.   
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_______________ b.  It contains grids of rows and columns that contain your data about 
specific topic. 

_______________ c. This object allows you to work with a specific set of records that  meet 
the criteria you have specified from a table in a database. 

_______________ d.  A type of database object that is used to enter, change, delete and 
display data in a database. 

_______________ e.  Term used for vertical columns in a table. 

_______________ f.  Term used for horizontal rows in a table. 

 
Answers to Student Activity 12.2.1 

 

Student Activity 12.2.1.1 

1. Database is a collection of data and a means to manipulate data in a useful way. It 
provides proper storage for large amounts of data, easy and fast access and facilitates 
the processing of data.  

2. Database software is a software application used by the user to manage and call the 
database. 

3.      Database software are the following: 

 DB2 

 Microsoft SQL Server 

 Oracle 

 Sybase 

 Interbase 

 Xbase 

 MySQL 

 dBaseIII 

 FoxPro 

 (Microsoft) Access 
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4.  The function of Database in: 

 Bank – customer data management, accounting, all banking transactions 

 Universities – Management of registration, alumni 

 Sales – Management of customer data, product, sales 

 Personnel – Management of employee data, payroll, tax 

 

Student Activity 12.2.1.2 

1. 

a. Document Tab Bar 

b. Record Navigation 

c. Navigation Pane 

d. Quick Access Toolbar 

e. Ribbon 

2. 

a.   Quick Access   b.   Ribbon 

c.   Navigation Tabs Bar  d.   Record Navigation  e.   Preview 

 

Student Activity 12.2.1.3 

1. The Help menu in Access assists the user when they are unable to complete a specific task.  
It gives guidelines and strategies to maximize the use of Access. 

2. The roles and ways to use help menu are: (1) Helps to solve problem.  Users can make use 
of the Help Menu if they encounter problems while using MS Access.  (2) Simple and 
Relevant.  MS Access Help menu is easy to use and provides appropriate assistance. (3) 
Ways to use help menu.  MS Access offers different ways on how to acquire assistance. 
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Student Activity 12.2.1.4 

1. 

a.  Table – A table contains grids of rows and columns that contain your data about a specific 
topic, such as name of products or name of persons. Tables organise data into 
vertical columns which are called fields and horizontal rows which are called 
records. 

b.  Form – A form can contain lines, colours and images together with check boxes, button and 
other features called controls.   

c.  Query – A query allows you to work with a specific set of records that meet the criteria you 
have specified from a table in the database.  You can use queries to view, change 
and analyse data in different ways. 

d.  Report – Reports allow you to present, organise, summarise and print all or part of the 

data in a database.   

2.   

a.  Table b.  Form 

 

Student Activity 12.2.1.5 

Your database may look like the sample below.  Result may vary on the information you want 

to put on your database. 
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Student Activity 12.2.1.6 

1. 
a. Click on the CLOSE Button, usually on the upper right-most corner of the 

window, to close Access. 

b.  Click on FILE TAB  and choose EXIT. 

2.  

 
3. The importance of closing unused tables or forms while working on your database is you 

can site up-to-date and prioritize needs, among other tasks. It makes your screen 
organize while doing your work. 

  

Answers to Summative Activity 12.2.1 
 

1.  

a. Check mark 

b. Check mark 

c. Cross mark 

d. Cross mark 

e. Check mark 

f. Cross mark 

2. Answers can be similar to these ones below. 

a. Press the function key F1 

b. Click on the help icon  

c. You can also seek Help from the internet 

3. Answers can be similar to these ones below. 

a. Record   b.  Table 

c. Query   d. Form 

e. Fields    f. Record 
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12.2.2 Working with Data, Table and Relationships 

12.2.2.1  Managing Data 

Database is a collection of related tables or information that can be organised in many ways. 
It is like keeping a set of file or record that contains any number of separate categories or 
entries which are called fields. 

Database is about storing your data in a table about a particular subject such as employees or 
products. Each record and field of the table contains data about one instance or attribute. 

Viewing an Object 
You can view an object in many ways. 

1. Right click on the object’s tab and on the context menu, select the view you would like to 
use. 

2. You can also use the View button to select the view that you would like to use. 

Navigating Between Records 
You can move around the table by clicking the mouse on a particular cell in the table or by 
pressing the following keys on the keyboard. 

Key Function 
Enter, Tab, Right Arrow Goes to the next field 

Left Arrow, Shift + Tab Goes to the previous field 

End Goes to the last field in the record 

Home Goes to the first field in the record 

Up Arrow Goes up one line in the record 

Down Arrow Goes down one line in the record 

Page Up Goes up one screen 

Page Down Goes down one screen 

 
You can click the Record Selector arrows to view first, previous, next or last record. 
 
 
 
 
 
 
 
Selecting Records and Fields 
Before you can edit a data or record, you have to select the data first. You can go to a 
particular cell and highlight the data to select it. You can also select records and fields quickly 
by clicking the record selector and field selector. To select more than one field or record, hold 
down the Shift key while clicking the field or record. 

Record Selector 
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Editing Records 
You can edit and make changes to your table by using the navigation buttons for easier 
movement around the table. To go to a specific record number, type the number in the 
Record Number box. The Record Pointer indicates the current record that you are in.  You can 
also use the Tab key or the mouse pointer to move to a cell. 

Open the table or form, click the cell and you can readily modify or delete the data. If the data 
you will be editing is from other pages, you can select the page from the Record Selector. 

There are many ways to delete a text. 

1. Point the mouse pointer at the end of the text you want to be removed and press the 
Backspace. 

2. Place the mouse pointer at the beginning of the text you want to be removed and press 
Delete. 

3. Drag the mouse pointer in order to highlight the text you want to be removed and press 
Backspace. 

4. Double click the text to highlight the word, then press Delete or Backspace. 

Using the Undo and Redo Buttons 
If you want to cancel or correct a recent mistake, use the Undo button to reverse the 
command or action. Use the redo button to restore a previous action. 

Deleting a Record  
You can delete an individual record or group of records. Once you have deleted a record, it is 
permanently removed. There are many ways to delete a record. 

1. On the Home tab, click Delete. 

2. Right click the gray box on the left side of the record. 

3. On the context menu, select Delete Record. 

4. A notification box will appear, stating that you are about to delete 1 record(s), then click 
Yes. 

Changing Field Properties 
As you are working on your database, you may find that you need to add or change field 
properties. The Field properties will allow you to further customise a field. 

Name Description 
Field Size It is the number of characters allowed in the field. 

Format Displays the numbers, dates, times and texts. 

Input Mask Allows you to control the data pattern or format.  You can also specify 
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characters that will be placed in the field automatically. 

Caption You can provide your own text to be used instead of the field names in the 
forms, tables, reports or queries. 

Default Value Allows you to set a field property that is common in most of the entries in 
your database. 

Required Specifies that you have to enter a value in a field.  Access will alert you if 
you have not entered a value. 

Decimal 
Places 

You can specify the number of decimal places. 

 
              Student Activity 12.2.2.1 

Answer the following questions. 

1.   Write the key to press on your keyboard to perform the following commands. Write your     
answers on the space provided after each number. 

a. Going up one line of the record.         ____________ 

b. You want to go to the next field of your database.      ____________ 

c. Going down one screen.          ____________ 

d. To go back to the previous field.        ____________ 

e. You want to go to the last field of the record.       ____________ 

2.   Name the field that is being described in each statement.  

a. Displays the numbers, dates, times and texts.      ____________ 

b. You can specify the number of decimal places in this field.    ____________ 

c. This field allows you to set a field property that is common in most of the entries in your 
database.            ____________ 

d. It allows you to specify characters that will be placed in the field automatically.   
            ____________ 

e. It is the number of characters allowed in the field.      ____________ 
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12.2.2.2  Controlling and Searching Records 

Sorting Records 
Sorting is arranging a list in a specific order. It is a powerful process when applied to a large 
number of records. You can sort alphabetically by ascending or descending order. You can sort 
by surname, first name, zip code or any field. Follow the steps below on how to sort records. 

For this topic you can make use of the data below so you can follow the steps that will be 
discussed later. This will be the template for the activities that will follow. Before you continue 
with the lesson, you must first create a table using the template below. Name this table as 
Customers. 

1. Open the table that you just created using the template provided above. 

2.  Click the field that you would like to sort.  For this example, click the Last Name. 
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3.  On the Home tab on the Ribbon, and locate the Sort & Filter group. 

4. Sort the field by selecting the Ascending or Descending command. 

a. Select Ascending to sort text A to Z or to sort numbers from smallest to largest. We 
will select this in our example because we want the last names to be in A-to-Z order. 

b. Select Descending to sort text Z to A or to sort numbers from largest to smallest. 

 

5. The table will now be sorted by the selected field. 

 

 

 

 

 

 

 

 

6. To save the new sort, click the Save command on the Quick Access toolbar. 

 
 
 
 
 
 
 
 
 

This is the result after applying Ascending Command. 
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Sorting Records by Multiple Fields 
You can do a multifield sort where you will specify a secondary field in case of a tie in the 
primary sort field. Follow the steps below on how to sort records by multiple fields. 

1. On the Home tab on the Ribbon, and locate the Sort & Filter group and click on Advanced 
and select Advanced Filter/Sort. 

 

 

 

 

 

 

 

 

 

Note:  After you save the sort, the records will stay sorted that way until you 

perform another sort or remove the current one.  To remove sort, simply click 

the   Remove Sort command. 
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2. The Query grid will appear on the window. 

 

 

 

 

 

3.   Drag the fields you want to sort into the grid in the order you want to apply them. 

4.  For each field in the grid, click the arrow to choose between Ascending and Descending. 

 

 

 

 

 

 

 

5.   On the Sort & Filter group, click Toggle Filter. 

 

 

 

 

 

 
 
 
 
 
 
 

The image displays the Ascending command 

Note:  Toggling your filter allows you to turn it in and off.  To view 

records without the filter, simply click the Toggle Filter command.  To 

restore the filter, click it again 
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Filtering Records 
Filter can temporarily isolate and view a specific set of records to work with while you have a 
form or datasheet displayed. 

Filter is a simple form of a query – they are used primarily to quickly view a subset of records 
when you are using a form or datasheet. A filter is a set of criteria applied in order to sort a 
data. A filter removes records that do not match the specified criteria. Filters can only be 
viewed and they cannot be saved. 

Types of Filters 
a.  Filter by form allows you to enter values into a form to specify filter criteria. To select a 

record, you can encode criteria into a form. 
 
b.  Filter by selection retrieves data that match a selected example. You can highlight the 

value in the field as the criteria for the selection. 
 
c.  Filter by excluding selection excludes the value you highlight as the criteria or the 

selection. 

d.  Advanced filter/sort allows you to enter complex multiple criteria for filtering and to 
specify a sort order.  This filter duplicates a query or creates a more complicated selection. 

 
A.  Create Simple Filter 
 Follow the steps below on how to create a simple filter. 

1. Open the template Customers that you have created 

2. Click the drop-down arrow next to the field you want to filter by. You will filter by the city 
because we want to see a list of customers who live in a certain city 
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3. A drop-down menu with a checklist will appear. Only the check items will be included in 
the filtered results. Use the following options to determine which items will be included in 
your filter:    

 Select and deselect items one at a time by clicking their check boxes. Here, you 
will deselect all of the options except for Cary. 

 Click Select All to include every item in the filter. Clicking Select All a second 
time will deselect at all times.  

 Click Blank to set the filter to find only the records with no data in the selected 
field. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
4.  Click OK. The filter will be applied. Customers table now displays only customers who live 

in Cary. 

 

 

 

 

 

 

 

 

  



              

              GR 12 ICT M2 DATABASE 2 

 

 47 

 

B.  Create Filter from a Selection 
 Filtering by Selection allows you to select specific data from your table and find data 
 that is similar or dissimilar to it. For instance, if you were working with a bakery’s 
 database and wanted to search for all products whose names contained the word 
 chocolate, you could select that word in one product name and create a filter with that 
 selection. Creating a filter with a selection can be more convenient than setting up a 
 simple filter if the field you are working with contains many items. 
 
 For this topic use the template below and save using the file name Pastries.   

 
1. Open the template Pastries that you have just created. 

2. Select the cell or data you want to create a filter with. You need to see a list of products 
that contain the word chocolate in their names, select the word chocolate in the 
Product Name field. 
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3. Select the Home tab on the Ribbon, and locate the Sort & Filter group. 

4. Click the Selection drop-down arrow. 

 

 

 

 

 

5. Select the type of filter you want to set up: 

 Contains includes only records with cells that contain the selected data. We 
will select this because we want to see records that contain the word chocolate 
anywhere in the title. 

 Does Not Contain includes all records except those with cells that contain the 
selected data. 

 Ends with includes only records whose data for the selected field ends with the 
search term. 
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 Does Not End With includes all records except those whose data for the 
selected field ends with the search term. 

 

 

 

 

 

 

 

 

 

 

6. The filter will be applied. Your table should now display only the products with 
chocolate in their names. 

 

 

 

 

 

 

 

 
 
C.  Filtering numbers with a search term 
 The process for filtering numbers with a search term is similar to the process for filtering 
 text.  However, different filtering options are available to you when working with 
 numbers. In addition to Equals and Does not Equal, you can choose: 
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 Greater Than, to include only records with numbers in that field that are greater 
 than or equal to the number you enter. 

 Less Than, to include only records with numbers in that field that are less than or 
 equal to the number you enter. 

 Between, to include records with numbers that falls within a certain range. 

 Follow the steps below on how to filter numbers with a search term. 

1.   Click the drop-down arrow next to the field you want to filter by. We want to 
filter the records in our menu items table by price, so you will click the arrow in 
the Price field. 

 

 

 

 

 

 

 

 

 

 

 

 

2. In the drop-down menu, 
hover your mouse over the 
words Number Filter. From 
the list, select the way you 
want the filter to match 
your search term. In this 
example, you will create a 
filter that will show 
inexpensive items only, 
select Less Than. 
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3.  The Custom Filter dialog box will appear. Type the number or numbers you 
want to use in your filter. Type 5 so the filter will show only menu items that 
cost $5 or less. 

 

 

 

 

 

4.   Click OK. The filter will be applied. 
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 Student Practical Activity 12.2.2.2 

Make use of the data provided and perform the following: 

1. Open the template Customer. 

2. Sort the Customer’s Last Name in ascending order. 

3.   Filter the list of customers that lives in Durham. 

4.   Provide a snapshot or print screen image of the output. 

12.2.2.3  Creating Tables 

What is Database Table? 

All database objects rely on the existence of a database table. A table contains grids of rows 
and columns that contain your data about a specific topic, such as name of products or name 
of persons. Tables organise data into columns (called fields) and rows (called records). 

Each record contains data about one instance of the table subject, such as a particular 
employee. A record is also commonly called a row or an instance. 

Each field contains data about one aspect of the table subject, such as first name or email 
address.  A field is also commonly called a column or an attribute. 

Designing a Table 
Before entering data in each of the sections in the table, you must first know the data you 
need to enter in the fields. 

 Field Name contains the person’s name, address, phone and birthday. 

 Data Type tells Access what kind of information can be stored in the field. 

 Description explains the data in the field. It will only appear in the status bar but not in 
 the table. 

Creating a Table from the Application Parts 
This is an easy way to create a table. Follow the steps below on how to create a table from the 
Application Parts. 
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1. Click Application Parts and a list of templates showing tables or combination of tables 
and reports will show. 

2. Select the table that you would like to use. 
 

3. As an example, click Contact and the Navigation Pane will show Tables, Queries, Forms 
and Reports templates. 

Creating a Table in Datasheet View 
Datasheet view provides a visual way to create a table. You start by creating a new, blank 
database or by adding a new table to an existing database. Either method opens a new table 
in Datasheet view. 

1. Click the Create tab. 

2. In the Tables group, click Table.   
 
 
 
 

Once you clicked the Table in the Create Tab it will show you similar to the one below.   
 
 
 
 
 
 
 
 
 

4 

3 

1 

2 

2 
1 



 

                   GR 12 ICT M2 
DATABASE 2 

 

54  

 

Notice that the new table contains a field called ID. That is your primary key, so you do not 
need to create one. 

3. Click the down arrow at the right of the first blank field header and select a data type.  

 
 
 
 
 
 
 
 
 

 Below is the sample screen shot once you click on the arrow to select the data type.   

 

 

 

 

 

 

 

4. Click the blank field header and enter a name for the field. You just type the field name 

 and press ENTER. Doing that shifts the focus to the next field, where you repeat the 

 process. As you work, remember that if your field names contain more than one word, 

 do not use spaces between the words. 

 

 

3 

 To add your fields, click the first blank field header – the words Click to Add. That              

starts a menu of data types, and you select a data type for the field. After that, the 

field header then becomes available for writing. 
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5. Repeat steps 3 and 4 until you have created all the fields for the table. 

6. When you are done, press CTRL+S and give the table a name. 

Creating a Table using Quick Start fields 
Quick Start fields are a faster way to build parts of a new table. The fields capture data for 
common business needs, and all field names and data types are set for you. Access adds the 
fields for you, with field names data types already set. Follow the steps below on how to 
create a table using the Quick Start fields. 

1. Click the Create tab. 

2. In the Tables group, click Table. 

 

 

 

 

 

 

3. Click on the Fields tab, in the Add & Delete group, click More Fields. 

 

4 

Note:  It is a common practice to remove spaces entirely, or separate each word 
with an underscore. Also, at this point, do not add any foreign key fields or 
lookup fields. You will add one type of lookup field later in the upcoming lessons. 
You will add foreign keys when you create your table relationships.  This can be 
found in the second table and refers to the primary key on the first table.  Foreign 
key is a field in one table that uniquely identifies a row of another table.  More of 
this will be discussed in the next lesson. 

2 
1 
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4. Scroll down the menu to the Quick Start section and select the type of field you want to 
add to your table, such as Address, Name, or Start and End Dates. 

 

 

 

 

 

 

 

 

 

 

5. Use a combination of Quick Start fields and Datasheet view to finish creating your table. 

6. When you are done, press CTRL+S and give the table a name. 

You can use the new fields right away — just start entering data — or you can rename them, 
and remove fields you don't need. Also, you may have noticed what seem to be spaces in the 
field names. Do not worry; you are not looking at the actual field names. Instead, you are 
looking at captions, user-friendly text associated with each field name. 

Creating a Table in Design View 
Design view allows you to build a table from scratch and set or change every available 
property for each field. You can also open existing tables in Design view and add, remove, or 
change fields. Follow the steps below on how to create a Table in the Design View. 

 

3 

4 
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1. Click the Create tab. 

2. In the Tables group, click Table Design. 

3. Click Click to Add, to add field. 

 

 

 

 

 

 

 

 

 

 

4. Select data types for each field from the lists in the Data Type column. 
5. Enter field names in the Field Name column. 

 

 

 

 

6. When finished, press CTRL+S and give the table a name.  

 

Setting the Fields in a Table 
When adding a field in your table, the first step that you will go through is to Click to Add a 
field.  On this step Access will now ask you what type of files are you trying to create. Follow 
the steps below. 
 

5 

3 

4 
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1. Click the Click to Add tab. Access will display the different types of fields that you can 
use in creating a table.   

 

 

 

 

 

 

 

 

 

 

2. Choose the data type for each field that you will use. Here choose the data type which 
depends on the data to be entered on each field.  Select the DataType: Text if you want 
text and numbers on your table. Select Number if you want data to be calculated.  Select 
Hyperlink for an email field. Other types will be discussed further on this lesson. 

3. To save the table, click the Save button from the Quick Access Toolbar and on the Save 
dialog box type your file name. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Save Button in the Quick 

Access Tool Bar. 

Type the file name. 
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Field Types 
The following below are the different field types and their functions. 

Icon Name Function 

 

 
 

Short text 
 
 

Allows you to add texts 

  
Number 

 
 

Allows you to add numbers 

 

 
Currency 

 
 
 

Allows you to add currency 

 

 
Date & Time 

 
 

Allows you to add date and time 

 

Yes/No 
 

Allows you to add more fields 

 

Lookup and Relationships 
 
 

Allows you to create and view lookup and 
relationships 

 

 
Rich Text 

 
 

Allows you to format text 

 

 
Long text 

 
 

Allows you to add memo 
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Attachment 

 
 

Allows you to add attachment 

 

 
Hyperlink 

 
 

Allows you to create hyperlink 

 
Characters to avoid when creating a field name 
You can use spaces in field names, but they make it difficult to write VBA code and 
expressions. However, you cannot use the following characters or symbols in field names or 
object names. In Access, objects are any of the components that make up your database. 
Tables, queries, forms and other components are all "objects." 

a. Periods (.) 

b. Forward slashes (/) 

c. Asterisk (*) 

d. Semicolons (;) 

e. Colons (:) 

f. Exclamations points (!) 

g. Pound sign (#) 

h. Ampersand (&) 

i. Dashes (-) 

j. Question Marks (?) 

k. Double quotes (“) 

l. Single quotes (‘) 

m. Dollar sign ($) 

n. Percent sign (%) 
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Creating a Table from the Layout View 
This is the easiest way to construct a table. Follow the steps below on how to create a Table 
from the Layout View. 

1. Click Create tab. 

 

 

 

 

 

2. Click Table, click the Fields tab, and click More Fields. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click Create Tab. 

2 

On Quick Start group, 

select Name. 
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3. On the list, you will see the Quick Start group, select Name and the window will display 
Last Name and First name fields. 

 Your table should look like the sample below. 

 

 

 

 

Note: You can delete the fields that you will not use by right clicking the Field name 
and on the context menu, click Delete or on the Ribbon; click the Delete button. 
 

4. Go back to the More Fields and select Address and the window will display the standard 
address fields such as City, State, Province and Country.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 Your table should look like the sample on the next page. 

Table after adding Name from Quick Start group 

On Quick Start group, select 

Address. 
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Table after adding Address from Quick Start group 

Click to add more fields. 

 

5. To add additional fields manually, click the Click to Add arrow. On the list, select Text if 
you want your field to contain text or numbers. On the field name area, type the name 
for your new field. 

 

6. To save the table, click the Save button from the Quick 
Access Toolbar and on the Save Dialog box type your file name. 

Saving the Table 
You can save a table in many ways. Follow the steps below on how to save a Table. 

1. On the Quick Access Toolbar, click the Save button. 

                                                  OR 

1. Right click on the Table tab and on the context menu, select Save. 

 

 

 

 

 

2. On the Save Dialog box, type your table 
name. 

 

3. Click OK. 

 
 
 

Select Save. 
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Closing the Table 
All the tables that you have opened will be displayed with their corresponding tabs. You have 
to close the table when there are many open tables or when you finished using the table. You 
also have to close a table before performing a specific task such as renaming a table. Follow 
the steps below on how to close a Table. 

1. Right click on the table tab. 

 

 

 

 

                                            OR 

2. On the File tab, select Close. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Select Close. 

Click File Tab. 

Click Close. 
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              Student Activity 12.2.2.3 

 

Answer the following. 

1. True or False.  Decide whether the statement is correct write True, otherwise write 
False if the statement is not true on the space provided. 

a. There is only one way to create a table in Access 2010.     
 ____________ 

b. Field names can be deleted.         
 ____________ 

c. It is not possible to add more fields on your table.      
 ____________ 

d. You can rename your table.          
 ____________ 

e. If you want to create a table from scratch you start creating using Design view.    
            
 ____________ 

f. Datasheet view provides a visual way to create a table.    
 ____________ 

g. There are number of ways to save your table.        
____________ 

h. Each table has its corresponding table tabs.       
 ____________ 

i. Dollar sign ($) should be avoided when creating a field name.   
 ____________ 

j. Data type Text allows you to add text and numbers on your table.  
 ____________ 
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2.  Create a Sales Representative Directory table that will contain the following. What data 
type should be used in each field name? Complete the table. 

Field Name Data Type Description 

ID Number  
Sales Representative’s ID 

Number 

Full Name  
Sales Representative’s full 

name 

Address  
Sales Representative’s  

address 

Province  
Sales Representative’s  

province 

Age  Sales Representative’s  age 

Birthday  
Sales Representative’s  

date of birth 

Mobile Number  
Sales Representative’s  

mobile number 

Email address  
Sales Representative’s  

email address 

Items Sold  
Sales Representative’s  

sold items 

Item Price  Price of items 

 
 

Student Practical Activity  Open your MS Access and create a Sales 
Representative Table sing the completed table above as your data to be used in 
the table. 
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12.2.2.4  Customising Tables 

Setting the Primary Key 
A primary key is a field or value that will uniquely identify the record. For example, in a 
student’s table, the primary key could be the student number and not the last name because 
a student number is unique to each student. Follow the steps below on how to set the 
primary key.  On this example you can use the table you created from the previous lesson. 
Otherwise, creating a new table will be still applicable. 

1. On the Home tab, click View and select Design View. 

 

 

 

 

 

 

 

Note:  Access will be asking you to save your table first before you can finally assign 
a Primary key. 

2. Click the row for the field that you want to set as the primary key. 
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3. On the Ribbon, click Primary Key and a key symbol will be displayed on the left side of 
the field. 

 

 

 

 

 

 

 

 

 

Modifying Tables 
When you modify your table the changes you can make to your table will not only look your 
table nice but it can make the table easier to read too. 

Resizing fields and rows 
You can make use of the table you have created in the previous lessons for this topic. Images 
on this topic are just examples on how it will look like. Follow the steps below on how to 
resize fields and rows. 

To resize a field 

1. Place your cursor over the right gridline in the field title. Your mouse will become a 
double arrow         .  

Key symbol on the left 

side of the field. 
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2. Click and drag the gridline to the right to increase the field width or to the left to 
decrease the field width. 

3. Release the mouse. The field width will be changed. 

 

 

 

 

 

 

 

To resize a row 

1.  Place your cursor over the bottom gridline in the gray area to the left of the row. Your 
mouse will become a double arrow. 

   

 

 

 

 

4. Click and drag the gridline downward to increase the row height or upward to decrease 
the row height. 

5. Release the mouse. The row height will be changed. 
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Table Formatting Options 
Alternating Row Color 
By default, the background of every other row in an Access table is a few shades darker than 
the background of the rest of the table. This darker alternate row color makes your table 
easier to read by offering a visual distinction between each record and the records directly 
above and below it.  Below is a sample of an alternate row color. Follow the examples after 
the picture on how to change alternate row color. 

 
To change the alternate row color 
 
1. Select the Home tab located the 

Text Formatting group. 

2. Click the Alternate Row Color 
drop-down arrow. 
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3. Select a colour from the drop-down menu, or select No Color to remove the alternate 
row color. 

 

 

 

 

 

 

 

 

4. Your alternate row color will be updated. 

Modifying Gridlines 
Another way Access makes your tables easier to read is by adding gridlines that mark the 
borders of each cell. Gridlines are the thin lines that appear between each cell, row, and 
column of your table. By default, gridlines are dark gray and appear on every side of a cell, but 
you can change their color or hide undesired gridlines.  See the sample below. 
 
 
 
 
 
 
 
 
 
 
 
 
Follow the steps below on how to customize which gridlines appear. 

1. Select the Home tab, and locate the Text Formatting group. 
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2. Click the Gridlines drop-down arrow. 

 

 

 

 

 

3. Select the gridlines you want to appear. You can choose to have horizontal gridlines 
between the rows, vertical gridlines between the columns, both types of gridlines, or 
none at all. 

 

 

 

 

 

4. The gridlines on your table will be changed. 

 

 

 

 

 

 

Student Practical Activity 12.2.2.4 
 

Follow the instructions below. 

A.   Apply the methods you learned from this lesson. Customise the Sales Representative and 
Customers’ table you have made from the previous lesson.  Follow the instructions below. 

a. Open the Sales Representative’s table you created from the previous lesson. 
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b. Apply Table Design and colour on your table. 

c. Change the font style and size according to your desired output. 

B.   Create a Customers Directory table that will contain the following. What data type should 
be used in each field name?  Complete the table. 

 

Field Name Data Type Description 

Customer Number  Customer’s ID Number 

Full Name  Customer’s full name 

Address  Customer’s address 

Mobile Number  Customer’s mobile number 

Email address  Customer’s email address 

Sales Representative  Customer’s Sales Rep 

 

In this activity you will: 

a. Set the Customer Number as the primary key.   

b. Save the table using the Quick Access toolbar. 

c. Name the table as My Customers. 

d. Close the table using the context menu. 
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12.2.2.5  Getting External Information 

External Data 

An External Data are data that can be found outside the database that you are working on.  
External data source is a connection to an external database.  It usually contains data that 
does not change very much or data that is too large to bring.  You can link to a variety of 
external data sources, such as other database, text files, and Excel workbooks. When you link 
to external data, Access can use the link as if it were a table.  Depending on the external data 
source and the way you create the link, you can edit the data in the linked table, and can 
create relationships that involve the linked table. However, you cannot change the design of 
the external data by using the link. 

One of the most useful features of Access is its ability to interface with data from many other 
programs. Here are few ways in which you might use the data-exchange feature of Access. 

 To combine data that was created in other programs. 

 To transfer data between two other programs. 

 To accumulate and store data over the long term, occasionally exporting data to other 
programs such as Excel for analysis. 

Types of data that can import or link to 
In making database in Access you can either import or export data.  Import is to bring data 
into your working database from an external data source. Export on the other hand, is to 
bring out data from your database back to its external data source.   To be able to learn about 
the data formats that Access can import or export, click on the External Data tab on the 
ribbon. 

 

Import & Link displays icons for the data formats that Access can export data to. Export 
displays icons for all the formats that Access can export data to. 

 

 Note:  You can click on More to see more formats that Access can work with. 
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Import or link to data in another format 
Follow the steps on how to import or link data in another format. 

1. Open the database that you want to import or link data to. 

2. On the External Data Tab, under Import and Link group, click the type of data that you 
want to import or link to. For example, if your source data is in a Microsoft Excel 
workbook, click Excel. 

 

 

 

 

 

 

 

3. External data Wizard will open. 

External Data Wizard 
In most cases, Access starts with External Data Wizard. You may be asked for some or 
all of the information in the following list: 

 Specify the source of the data (its location on disk). 

 Choose whether to import or link to the data. 

 If importing, choose whether to append the data to an existing table, or to 
create a new table. 

 Specify exactly which data in the document you want to import or link. 

 Indicate whether the first row contains column headings, or whether it should 
be treated as data. 

 Specify the data type in each column. 

 Choose whether to import the structure only, or the structure and the data 
together. 

 If importing, specify whether you want Access to add a new primary key to the 
new table, or use an existing key. 

Click Excel. 
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 Specify a name for the new table. 

4.  The last step is saving the details of the import or link operation. If you still need to 
perform the same operation, select the Save import steps check box, fill the information, 
and then click Close. 

After completing the wizard, Access will notify you of any problem that might have occurred 
during the import process. In some cases, Access might create a new table called 
ImportErrors, which contains data that was not imported successfully. You can use this to 
examine and check why data was not imported correctly. 

Student Activity 12.2.2.5 

Follow the steps below.  In this activity we will use the tables that you have created from 
the previous lesson.   

1. Close all open tables. 

2. On the Database Tools tab, click Relationships. 

 

 

 

 

3. On the Relationship Tools Design tab, click the Show Table button. 

 

 

 

 

4. On the Show Table dialog box, double click each of the tables.  In this activity we will use 
 the Customers Table and the Sales Representative Table. 

5. On the Customers Table you will see Sales Representative field which gets information 
 from the Sales Representative table. 

6. Click Primary key on the Sales Representative table which is the ID, click and drag it to 
 the Sales Representative field in the Customers Table. 
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7. On the Edit Relationship dialog box, check the Enforce Referential Integrity, Cascade 
 Update Related Fields and Cascade delete Related Records. 

 

 

 

8. You will also notice the One to Many Relationship which means that one Sales 
 Representative can have many Customers. 

9. Click Create. 

10. You will notice that on the “One” side, each record contains a unique entry for the 
 joined field. 

11. On the “Many” side, multiple records can have the same value for the joined field. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Checking these boxes means that whatever update you make in the Employee ID 
field will reflect on the other table that uses the field.Enforce Referential 
Integrity ensures consistency & validates corresponding entries.  Cascade Delete 
Related Records ensures removal of all related data from one table related to the 
table being deleted. 
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12.2.2.6  Managing Relationships 

In a database, relationships are critical because they are how your tables "talk" to each other. 
If your tables do not talk, you cannot get answers from your data, and you will see how that 
works in this lesson. You create relationships by using a field from one table as a field in a 
related table. 

One of the advantages of Relational Database Management System such as Access 2010 is to 
easily setup tables and relationships with constraints to make them more tightly followed. 
One of the features is the ability to create and maintain relationships between tables. MS 
Access is a relational database where data are split into tables that are connected. 
Relationships exist when two or more tables have a connection or association. 

After setting up different tables for each subject in your database, Access can bring that 
information back together again. You can connect tables by creating relationships between 
them based on a common field that they share. First, you have to define the relationships 
between your tables. Then, you can create queries, forms and reports to display information 
from several tables at once. 

The fields in the tables must be coordinated so that they show information about the 
customer.  This coordination is accomplished by using table relationships.  A table relationship 
works matching data in key fields.  A key field is a field with the same name in both tables.  In 
most cases, these matching fields are the primary key from one table and a foreign key in the 
other table.  As discussed from the previous lesson, primary key provides a unique identifier 
for each record. On the other hand, a foreign key is used to link a table to another table.  For 
example, customers can be associated with the orders by creating a table relationship 
between the Customer Table and Order Table. 

Relationships have “sides” 

At this point, it helps to think of relationships has having “sides.” For example, one supplier 
can provide many assets, so the Supplier’s table resides on the "one" side of the relationship, 
while the Assets table sits on the "many" side. 

There are three types of table relationships. 

A.  One-to-One relationship is when a single record in one table is related to a single record in 
another table, and vice versa. This type of relationship is not common because, most 
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often, the information related in this way is stored in the same table.  You might use a 
one-to-one relationship to divide a table with many fields, to isolate part of table for 
security reasons, or to store information that applies only to a subset of the main table.  
When you do identify such a relationship, both tables must share a common field. 

B. One-to-Many relationship is when one record in a table is related to many records in 
another table. For example, consider an order tracking database that includes a Customers 
table and an Orders table.  A customer can place any number of orders.  It follows that for 
any customer represented in the Customers table, there can be many orders represented 
in the Orders table.  The relationship between the Customers table and Orders table is, 
therefore, a one-to-many relationship.  

To represent a one-to-many relationship in your database design, take the primary key on 
the “one” side of the relationship and add it as an additional field or fields to the table on 
the “many” side of the relationship.  In this case, for example, Access will use the 
Customer Number in the Orders table to locate the correct customer for each order.  

Next, remember this rule: To create a one-to-many relationship, you use the primary key 
from the table on the "one" side as a foreign key in the table on the "many" side. The 
same rule applies to one-to-one and many-to-many relationships, but not in quite the 
same way. We will further discuss this lesson later. 

C. Many-to-Many relationship is when several records in one table are related to several 
records in another table. Consider the relationship between Products Table and Order 
Table.  A single order can include more than one product.  On the other hand, a single 
product can appear on many orders.  Therefore, for each record in the orders table, there 
can be many records in the products table.  In addition, for each record in the Products 
table, there can be many records in the Orders table.  That is why it is called many-to-
many relationship because, for any product there can be many orders and, for any order, 
there can be many products.   

Note:  To detect existing many-to-many relationships between your tables,                                                                                                              
it is important that you consider both sides of the relationship. 

 
A table relationship is represented by a relationship line drawn between tables in the 
Relationships window.  A relationship that does not enforce referential integrity appears as a 
thin line between the common fields supporting a relationship.  When you select the 
relationship by clicking its line, the line thickens to indicate it is selected.  If you enforce 
referential integrity for this relationship, the line appears thicker at each end.  In addition 1 
appears over the thick portion of the line on one side of the relationship, and the infinity 
symbol (∞) appears over the thick portion of the line on the other side. 
 



 

                   GR 12 ICT M2 
DATABASE 2 

 

80  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Relationship menu can be found in the Database Tools tab. 

 
Once the Relationships menu is open, on the Design tab you can find the following tools: 

Relationship that do not enforce referential integrity 

Relationship that enforce referential integrity 
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a.  Edit Relationships – opens the Edit Relationships 

dialog box.  When you select a relationship line, 
you can click Edit relations to change the table 
relationship.  You can also double-click the 
relationship line. 

b. Clear Layout – removes all tables and relationships from display in the Relationships 
window.  This command only hides the tables and relationships and it does not delete 
them. 

c.  Relationships Tools – creates a report that displays the tables and relationships in your 
database.  The report shows only the tables and relationships that are not hidden in the 
Relationship window. 

On the Design tab, in the Relationships group: 

a.  Show Table – opens the Show Table dialog box so you can select tables and queries for 
viewing in the Relationships window. 

b. Hide Table – hides the selected table in the Relationships window. 

c. Direct Relationships – displays all relationships and related tables for the selected table in 
the Relationships window, if they are not already displayed. 

d. All Relationships – Displays all of the relationships and related tables in your database in 
the Relationships window.   

 
 
 
 
 
 
e.  Close – Closes the Relationships window.  If you made any changes to the layout of the 

Relationships window, you are asked whether to save those changes. 
 
 

Note: Hidden tables (tables for which the Hidden check box in the table’s 
Properties dialog box is selected) and their relationships will not be 
shown unless Show Hidden object is selected in the navigation Options 
dialog box. 
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Creating a Table relationship by using the Relationships Window 
 
1.   On the File tab, click Open. 

2.  In the Open dialog box, select and open the database.  For this, you can open the 
Customer’s Table you have created from the previous lesson. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3.  On the Database Tools tab, in the Relationships group, click Relationships. 
 
 
 
 
 
 
 
 
 
 
 
4. If you have not yet defined any relationships, the Show Table dialog box automatically 

appears.  If it does not appear, on the Design tab, in the Relationships group, click Show 
Table. 

 
 
 
 
 
 
 
 
 

Open Dialog Box 
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5.  The Show Table dialog box displays all the tables and queries in the database.  To see only 

tables, click Tables.  To see only queries, click Queries.  To see both tables and queries, 
click Both.  For this lesson we will only select Tables, queries will be discuss later in the 
upcoming lessons.   

 
6.  Select one or more tables or queries and then click Add.  When you have finished adding 

tables and queries to the Relationships window, click Close. 
 
7.  Drag a field (most commonly is the primary key) from one table to the common field (the 

foreign key) in the other table.  To drag multiple fields, press CTRL key, click each field, and 
then drag them. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Show Table dialog box 

Show Table Command 

Sele

ct 

Open Tables to establish Relationships 
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8.  The Edit Relationships dialog box 
appears.  Verify that the field 
names shown are the common 
fields for the relationship.  If a field 
name is incorrect, click the field 
name and select a new field from 
the list.  To enforce referential 
integrity for this relationship, 
select the Enforce Referential 
Integrity check box.   

 
 
 
 

 
 
 
9.  Click Create.  The relationship line is drawn between the two tables.  If you selected the 

Enforce referential Integrity check box, the line appears thicker at each end.  Your output 
maybe similar to the one illustrated. 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
To create One-to-One Relationship 
Both of the common fields usually the primary key and foreign key fields) must have a unique 
index.  This means the Indexed property for these fields should be set to Yes (No duplicates).  
If both fields have unique index, Access creates a one-to-one relationship. 

You may not use one-to-one relationships very often, but you should know how to create 
them. You start by creating a one-to-many relationship, and then you change the indexing. 

Relationship established between Customers and Orders Tables 

Note:  Referential Integrity is a property of data which, when satisfied, 
requires every value of one attribute (column) of a relation (table) to exist as 
a value of another attribute in a different (or the same) relation (table). 
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Access uses indexing in the same way that you use an index in a book — to find information 
quickly. When you create a primary key, Access automatically indexes that field, and that 
makes searches faster. 

To create One-to-Many Relationship 
In a one-to-many relationship, the primary key has indexing turned on, but the foreign key 
field has indexing turned off. In a one-to-one relationship, both key fields have indexing 
turned on, and neither field allows duplicate values. 

Creating Many-to-Many Relationship 
To represent a many-to-many relationship, you must create a third table, often called a 
junction table that breaks down the many-to-many relationship into one-to-many 
relationships.  You insert the primary key from each of the two tables into the third table.  As 
a result, the third table records each occurrence, or instance, of the relationship.  For 
example, the Orders table and the Products table have a many-to-many relationship that is 
defined by creating two one-to-many relationships to the Order Table.  One order can have 
many products, and each product can appear on many orders.   
 
Common Field 
For a relationship to exist between two tables, they must have a common field. For example, 
the Inventory table has an item ID field, and a Customer’s Order table has also an Item ID 
field, the two tables can be joined or related by that field.  The field type must be the same in 
both tables for a relationship to exist. 
 
Editing a Relationship 
You can change the relationship even after you have created it. You can change the referential 
integrity options or the join type option. 
 
1. Close any tables that are open because you cannot 

modify relationships between open tables. 

2. In the Relationship window, double click the 
connector between the two tables or click Edit 
Relationships button from the Design tab. 
 

3. On the Edit Relationship dialog box, 
click the Deselect the Enforce 
Referential Integrity check box, 
Cascade Update Related Fields 
check box, or Cascade Delete 
Related Records check box. 

4. Click OK.  
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1. Close all open tables. 

2. On the Database Tools tab, click Relationships. 

 

 

 

3. On the Relationship Tools Design tab, click the Show Table button. 
 
 
 
 
 
 
 
 
 
4. On the Show Table dialog box, double click each of the tables. In this activity we will use 

the Customers Table and the Sales Representative Table. 

 

 

 

 

 

 

 

5. On the Customers Table you will see Sales Representative field which gets information 
from the Sales Representative table. 

6. Click Primary key on the Sales Representative table which is the ID, click and drag it to 
the Sales Representative field in the Customers Table. 

Student Practical Activity:   
Follow the steps below.  In this activity, we will use the Customers and Sales 
Representative tables that you have created from the previous lesson.   
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Checking these boxes means that whatever update you make in the Employee ID 
field will reflect on the other table that uses the field. Enforce Referential Integrity 
ensures consistency & validates corresponding entries. Cascade Delete Related 
Records ensures removal of all related data from one table related to the table 
being deleted. 

 
7. You will also notice the One to Many Relationship which means that one Sales 
 Representative can have many Customers. 

8. Click Create. 

9. You will notice that on the “One” side, each record contains a unique entry for the 
 joined field. 

10. On the “Many” side, multiple records can have the same value for the joined field. 

 

Student Activity 12.2.2.6 

Answer the following. 

1. What is the importance of establishing relationships between tables? 

 ________________________________________________________________________

 ________________________________________________________________________ 
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2. List the three types of relationships. In your own words, define each type of relationship. 

 1.

 _______________________________________________________________________

 _______________________________________________________________________

 2.

 _______________________________________________________________________

 _______________________________________________________________________ 

 3.

 _______________________________________________________________________

 _______________________________________________________________________

 _______________________________________________________________________ 

 

Summative Activity 12.2.2 
 
Answer the following. 

A.  How can you create one-to-one relationship? 

_____________________________________________________________________________

_____________________________________________________________________________

_____________________________________________________________________________

_____________________________________________________________________________

_____________________________________________________________________________

_____________________________________________________________________________

_____________________________________________________________________________

_____________________________________________________________________________

_____________________________________________________________________________ 

B. What happens when you check Enforce Referential Integrity and Cascade Delete Related 
Records in Edit Relationship dialog box? 

_____________________________________________________________________________

_____________________________________________________________________________
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_____________________________________________________________________________

_____________________________________________________________________________

_____________________________________________________________________________

_____________________________________________________________________________

_____________________________________________________________________________

_____________________________________________________________________________

_____________________________________________________________________________

_____________________________________________________________________________ 

C. Perform the following 

1. Create a Student and an Instructor table. 

2. Establish a relationship between two tables. 

 
Answers to Student Activities  
 

 

Student Activity 12.2.2.1 

A.  Write the key to press on your keyboard to perform the following commands. Write your 
answers on the space provided after each number. 

1. UP Arrow 

2. Enter, Tab or Right arrow 

3. Page Up 

4. Left Arrow, Shift + Tab 

5. End 

B.   Name the field that is being described in each statement.  

1. Format 

2. Decimal Places 

3. Default Value 
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4. Input Mask 

5. Field Size 

 

Student Activity 12.2.2.2 

Follow the steps to perform this activity 

1. Click the Last Name Field. 

2. On the Home tab, on the ribbon, click the Sort & Filter group. 

3. Click the Ascending icon. 

 

Student Activity 12.2.2.3 

A. 

1. False 

2. True 

3. False 

4. True 

5. True 

6. True 

7. True 

8. True 

9. True 

10. True 

B.  In this activity, follow the steps below: 

1. Create the table. 

2. Create ten field names.  Data types are the following. 
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Field Name Data Type 

ID Number Text 

Full Name Text 

Address Text 

Province Text 

Age Text 

Birthday Date 

Mobile Number Text 

Email address Text 

Items Sold Text 

Item Price Number 

3. Click on the ID Number and click the Primary Key icon.   

4. Name your table as Sales Rep. 

5. Click  

 

Student Activity 12.2.2.4 

A.  In this activity, follow the steps below: 

1. Open the Sale’s Representative’s table. 

2. On the Create tab, click the table Design button. 

3. The Ribbon will display the Table Tools Design tab which contains tools that will allow 
you to design your table. 

4. To change the design of the table, on the Create tab, click the Table button. 

5. The Ribbon will display the Fields tab and the Table tab which contains tools that will 

allow you to design your table. 

6. On the Home tab, click the Alternative Row colour button. 

7. On the colour palette, select the colour that you want to use. 
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8. To change the font size, on the Home tab, click the Font name or Font size arrow. 

9. On the list, select the font name or size that you would like to use. 

10. To change the font style, on the Home tab, click Bold B, Italic I or Underline 

B.  In this activity, follow the steps below: 

1. Create the table. 

2. Create ten field names.  Data types are the following. 

Field Name Data Type 

Customer Number Text 

Full Name Text 

Address Text 

Mobile Number Text 

Email address Text 

Sales Representative Text 

3. Click on the Customer Number and click the Primary Key icon.   

4. Name your table as Sales Rep. 

5. Click  

 

Student Activity 12.2.2.5 

1. Close all open tables. 

2. On the Database Tools tab, click Relationships. 

3. On the Relationship Tools Design tab, click the Show Table button. 
 
4. On the Show Table dialog box, double click each of the tables.  In this activity we will 

use the Customers Table and the Sales Representative Table. 

5. On the Customers Table you will see Sales Representative field which gets information 
from the Sales Representative table. 

6. Click Primary key on the Sales Representative table which is the ID, click and drag it to 
the Sales Representative field in the Customers Table. 
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7. On the Edit Relationship dialog box, check the Enforce Referential Integrity, Cascade 
Update Related Fields and Cascade delete Related Records. 

Student Activity 12.2.2.6 

Answers may be similar to these ones below. 

1. Relationships are critical because it is how the table communicate and connect to each 
other. If these tables created do not communicate to each other answers will not be 
possible from every data.  

2. One-to-One relationship is when a single record in one table is related to a single record 
in another table, and vice versa. For example, one specialized file server may have just 
one repair technician. 

One-to-Many relationship is when one record in a table is related to many records in 
another table. For example, one employee can use many assets, such as a computer, 
chair, and desk. 

Many-to-Many relationship is when several records in one table are related to several 
records in another table. 

 
Answers to Summative Activity 12.2.2 

Answers may be similar to the one below. 

1. To create one-to-one relationship, the steps are as follows: 

a. Close all open tables.  You cannot create or change relationships between open 
tables. 

b. In the Navigation Pane, right-click the table that contains the foreign key field, then 
click Design View. 

c. In the designer, click the foreign key field. 

d. Under Field Properties, on the General tab, click the list next to Indexed and 
select Yes (No Duplicates). 

e. Save your changes. 

2. To make sure that you data stay synchronized, you can enforce referential integrity 
between tables. Referential integrity relationships help makes sure that information in 
one table matches information in another. 
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12.2.3 Creating and Customising Queries 

12.2.3.1 Understanding Queries Using Query Wizard 

Queries are far more powerful than the simple searches or filters you might use to find data 
within a table. This is because queries can draw their information from multiple tables. For 
example, while you could use a search in the customers table to find the name of one 
customer at your business or a filter on the orders table to view only orders placed within the 
past week, neither would let you view both customers and orders at once. However, you 
could easily run a query to find the name and phone number of every customer who has 
made a purchase within the past week. A well-designed query can give information you might 
not be able to find out simply by examining the data in your tables. 

A Query allows you to work a specific set of records that meet the criteria you have specified 
from a table in the database. You can use queries to view, change and analyse data in 
different ways.   

Query is a request to perform an action on the data. Using Queries is like using the Find 
command with complex criteria.  For example, if you want to find a product that has a value of 
more than K300, you will have to use a special operation called query to search based on your 
given criteria. 

To create a query, you must provide three (3) information: 

1. The fields you want to search. 

2. The Search Criteria or the item that you are searching for. 

3. The fields that you want to display with the results. 

When you run a query, the results are presented to you in a table, but when you design one 
you use a different view. This is called Query Design View, and it lets you see how your query 
is put together. 

1. Query Views can be seen by clicking the View drop-down arrow to switch to another 
view of your query. The two main views are Datasheet View and Design View. 

2. Run Query is the command to view the results of the query in a table. 

3. The Object Relationship Pane is a small window that will display all the tables you 
choose to include in your query. It contains a 
list of every available field within the table. 

4. Design Grid can be seen in the bottom part of 
the Query Design View. It contains a table that 
lists all the fields included in the query. Here 
you can set criteria to specify which 
information the query should retrieve.   
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3 

1 
2 

4 
5 

6 

7 
8 

5. Field and Table Names are fields included in the query are located in the first row of the 
Design Grid. Beneath each field name is the name of the table that field belongs to. 

6. Sorting is available once data is retrieved by a query. Once the Sort row of the field is 
being clicked you can now either choose between Ascending or Descending. By default, 
query results are not sorted. 

7. Showing or Hiding Fields is used every time you design your query and it is necessary 
that you include the field, but it can be hidden in the query result. To do that, simply 
uncheck the checkbox in the Show row of the field. 

8. Query Criteria lets you specify exactly what type of information you want your query to 
retrieve. 

 

 

 

 

 

 

 

 

 

 

 

 
Using Queries with the Simple Query Wizard 
One way to create a simple query is to use the Query Wizard. This wizard is an attempt by 
Microsoft to once again make creating Access queries easy. This wizard does steps through 
the query design process in a logical way and it is a great place to start when learning about 
creating your first Access query.     

When you use the wizard, you have less control over the details of the query design, but the 
query is usually created faster than if you did not use the wizard. Moreover, the wizard can 
catch some simple design mistakes and prompt you to perform a different action. 
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The following are the steps on how to create query using Query Wizard.   

1. Open the Customers table you have created from the previous lesson. 

2. On the Create tab, click the Query Wizard.  

 
 
 
 
 
 
 
 
3. On the New Query dialog box, click the Simple Query Wizard and click OK. 

 

 

 

 

 

 

 

 

4. When the Simple Query Wizard opens, click the down arrow to select the table or other 
query from which you want to select fields. 

 
 
 
 
 
 
 
 
 
 
 
 
5. Click a field and click the right arrow to move the field to the selected Fields list.  You can 

click the double arrow to move all the fields at once. 

Choose Simple Query Wizard 
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6. You can pull as many fields as you 
want. 

7. Click Next. 

8. Type a name for the query and 
click Finish. 

9. The query results will now appear 
in the datasheet. 

 

 

 

 

 

 

 

 

Click arrows to 

select fields. 
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Student Activity 12.2.3.1 

Answer the following questions. 

1. Define Query in your own words. 

_______________________________________________________________________

_______________________________________________________________________

_______________________________________________________________________

_______________________________________________________________________ 

2. Enumerate the three (3) information you need to provide in creating query. 

________________________________________________________________________

________________________________________________________________________ 

 ________________________________________________________________________ 

________________________________________________________________________ 

3. Explain one way of creating a simple query. 

_______________________________________________________________________

_______________________________________________________________________

_______________________________________________________________________

_______________________________________________________________________ 

 

 

 

 

 

 

 

 

Student Practical Activity:  

Practice creating Query using the Simple Query Wizard.  Open the Sales 

Representative Table you created from the previous lesson and create a 

Query using the Simple Query Wizard. 
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12.2.3.2 Creating Queries Using the Query Design View 

The Query Design View will allow you to create a query that has full range of capabilities 
including filtering. 

A query can be based on tables or on other queries. To create a query, you open the table on 
which you are going to base your query in Query Design View, and then use the options in 
Design view to create our query.  

Follow the steps below on how to create a query using the Query Design View. 

1. Click the Create tab, and in the Queries group, click Query Design. 

 

 

 

 

2. In the Show Table dialog box, click the table you want to use, click Add, and then 
click Close to close the dialog box. 

 

 

 

 

 

 

 

 

3. In the table, double-click the fields you want to use in the query. Notice that the fields 
appear in the grid at the bottom of the designer. You can also drag fields from the table 
to an empty column in the grid. 
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On the Design tab, in the Results group, click Run. 

4. The query loads the data into a datasheet. 

5. Press CTRL+S to save the query, and in the Save As dialog 
box, enter a name. 

 

 
In Query Design view, each table has an option that allows you to display all the fields and all 
of the records in a table.  This option appears on the field line on the drop-down menu as the 
table name followed by a period and an asterisk (tablename.*) When you run a select query, 
Access displays the results in a datasheet. The result is called a record set, and you can work 
with it in the same way that you work with a datasheet. For example, you can add or change 
data, and Access will write your changes to the tables that serve as the record sources for 
your query. You can also use your record sets to provide data for forms, reports, and even 
other queries. For example, if you want a report on the computers that you need to replace, 
you can create a query that returns that data, and then quickly build your report.  

The image shows how a query yields a data to create a report. Report will be discussed on the 
upcoming lesson of this module.  The query returns only those records where an asset has 
been marked for retirement. 
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Remember 

that unlike tables, record sets do not physically exist in your database. Instead, Access stores 

the query, and it only displays a record set when you run the query. 

Student Activity 12.2.3.2 

A.  Answer the following questions. 

1. What is the function of Query command? 

 _______________________________________________________________________

 _______________________________________________________________________ 

2. Differentiate the two ways of creating a simple query. 

 _______________________________________________________________________

 _______________________________________________________________________ 

 

 

Remember that unlike tables, record sets do not physically exist in your 

database. Instead, Access stores the query, and it only displays a record set 

when you run the query. 

Student Practical Activity:  

Practice creating Query using the Query Design view.  Open the Customers and 
Sales Representative Table you created from the previous lesson and create a 
Query using Query design View. 
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12.2.3.3  Understanding Criteria 

Criteria are conditions that will determine which record will be included. The criteria will filter 
the query results. The criteria may be numeric or text.  It is better to specify a range of values 
than one specific value.  A query criterion is an expression that Access compares to query field 
values to determine whether to include the record that contains each value. 

Below are the 20 most commonly used criteria in Access Queries.   

1.  Simple Criteria for all Data Types. 

 

 

 

 

2.  Simple Criteria for Text. 

 

 

 

 

 

 

 

 

3.  Simple Criteria for Numbers. 
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4.  Simple Criteria for Date. 

 

 

 

 

 

 

 

 

 

 

 

Adding Criteria to a Query  
1.  Open the Customers Query in Design View.  Click on View and choose Design View. 

 

 

 

2. Identify the field for which you want to specify criteria.  
If a field that you want to specify a criterion for is not 
already in the design grid, you can add it by dragging it 
from the query design window to the design grid. 

3.  When the field that you want is in the design grid, you 
enter the criterion in the Criteria row for that field. 

     For example, you might specify the criterion =      
“Raleigh” for the City field.  Only records where the 
value of the city field is Raleigh will satisfy this criterion. 

Note:  When entering the criteria, write them exactly as they are written in the 
second column, replacing x with your search term, or in the case of dates, 
replacing mm/dd/yyyy with the desired date. 
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Before you proceed, open the table Pastries.  

 

 

 

 

 

 

 

 

Let us make use of the guidelines on how to specify a criterion using the data given. 

1.  Display only records where the value of the Product Type is Cakes. 

   Criteria = “Cakes” 

       On this example it will only display records of:  Black Forest, Black walnut, Buche de Noel, 
Carrot cake, Cheesecake, Coconut, Cookies n’ Cream, French Vanilla, German Chocolate, 
Gingerbread, Italian Rum and Red Velvet.  

2.  Display only records where the value of the product Type is Pies. 

         Criteria = “Pies” 

 On this example it will only display records of: Apple, Apple Crumb, Chocolate Cheese, 
Coconut cream, French Silk, key Lime, Peanut Butter Chocolate, Pecan, Pumpkin, Sweet 
Potato. 
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Student Activity 12.2.3.3 

Answer the following questions. 

1. Define criteria in your own words. 

__________________________________________________________________________

__________________________________________________________________________

__________________________________________________________________________ 

2.   Enumerate at least five (5) criteria values. 

__________________________________________________________________________

__________________________________________________________________________

__________________________________________________________________________

__________________________________________________________________________

__________________________________________________________________________ 
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12.2.3.4  Editing Query 

In creating Query you may come across on the instances of having some changes. You can 
insert, arrange and remove query fields. Follow the steps below on how to insert, remove and 
move a field. 

To insert a field 

1. On the Create tab, click Query Design. 

 

 

 

 

 

2. On the Query grid, click at the top of a field’s column to select it. 

 

 

 

 

 

 

 

 
3. On the Design tab, click Insert Columns. 

4. When a new blank column appears, drag the new field into the blank column. 

To remove a field 

1. On the Create tab, click Query Design. 

 

2. On the Query grid, click at the top of a field’s column to select it. 

3. On the Design tab, click Delete Columns. 
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To move a field 

1. On the Query Design view, click at the top of the field’s column to select it. 

2. Drag the left or right bar above the field to remove it. 

3. A black line will appear to show where the field is being moved. 

Filtering a Query 
Follow the steps below on how to filter a query. 

1.   On the Create tab, click Query Design. 

2.   On the Criteria row, type the value that you want to filter. 

3.   If the value is a data, enclose it with hash marks: #06/03/14#. 

4.   If you want to use a text string, enclose it with quotation marks: “PNG*” 

5.  If you want to specify a range of values, use greater than >, less than <, greater than or    
equal to >=, less than or equal to <= or equals =. 

6.  If you want to use ranges that are in between, type Between and add a space or type 
And then add a space. 

7.   You can also use Or and add space and type the next value. 

8.   Click View to check your work. 

Through simple logical operators in Query criteria you can set criteria by using simple AND/OR 
operators, which enables you to confine the results of a query based upon the query criteria 
to check which table field data is to be included.  

 

 

 

 



 

                   GR 12 ICT M2 
DATABASE 2 

 

108  

 

Student Activity 12.2.3.4 

 
Arrange the following steps. 

 
1.  To remove a field in a query.  Use numbers 1 to 3. 

_____  On the Query grid, click at the top of a field’s column to select it. 

_____  On the Create tab, click Query Design. 

_____  On the Design tab, click Delete Columns. 

2. To insert a field in a query.  Use numbers 1 to 4. 

_____  On the Design tab, click Insert Columns. 

_____  On the Create tab, click Query Design. 

_____  When a new blank column appears, drag the new field into the blank column. 

_____  On the Query grid, click at the top of a field’s column to select it. 

3. To move a field in a query.  Use numbers 1 to 3. 

_____  Drag the bar above the field left or right to remove it. 

_____  A black line will appear to show where the field is being moved. 

_____  On the Query Design View, click at the top of the field’s column to select it. 
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12.2.3.5  Creating Advanced Query 

The type of query that you created in the previous section can return a lot of data. A common 
way to limit what the query returns is to use a parameter. A simple parameter makes the 
query ask for input before it runs. For example, if you only want to see records between 
certain dates, you can add parameters that make the query ask you for starting and ending 
dates and the query will give you just the records that fall between those dates. 

Creating a Query Asking an Input 
In other words, parameters are a type of filter that you build in to your query. Follow the 
steps below on how to create a query asking an input. 

1. Open the query in Design view, and in the Criteria row of the field you want to filter, 
enter your parameter. For example, you can use the criteria such as: Between [Start 
Date] And [End Date].   

2. When you run the query, the criteria asks you for a start date, then an end date, and it 
returns only the records that fall within the dates you specify. 

Creating a Query using Multiple Tables 
Finally, you can use multiple tables, or other queries, as the record source for a new query. In 
fact, you will query multiple record sources far more than you will single sources. Multi-source 
queries are how you answer questions such as; which assets came from which suppliers. 

The Query Wizard is the easiest way to get started building multi-source queries, especially if 
you are new to Access. You can refer to the previous lesson in creating query using Query 
Wizard. Follow the steps below on how to create a query using multiple tables. 

 

 

 

1. Click the Create tab, and in the Queries group, click Query Wizard. 

2. On the first page of the wizard, make sure Simple Query Wizard is selected, and then 
click OK. 

3. Open the Tables/Queries list and click the first table you want to use. 

4. In the Available Fields pane, click the first field you want to use in the query, and then 
click the right-arrow button to move the field to the Selected Fields pane. 

5. Repeat step 4 to add any other fields from that table. 

6. Open the Tables/Queries list and select the second table you want to use. 

Remember that any tables in the record source must participate in a relationship. 
For example, you cannot extract the names of your employees from one source 
and the assets that they use from another unless those tables are related. If the 
tables in your record source are not related, the query returns all the data from 
each table, and that kind of result has extremely limited uses. 
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7. Repeat step 4 to add fields from the second table to the query, and then click Next. 

8. In the What title do you want for your query text box, enter a name for the query, then 
click Finish. 

Creating a Query using Formula 
Another common way to alter the selection criteria in a query is to add a function. For 
example, if you want to know how much your company spent on office furniture last year, you 
can add an aggregate function to the query and the sum will appear in your results. Follow the 
steps below on how create a query using a formula. 

1. Open your query in Design view. 

2. On the Design tab, in the Show/Hide group, click Totals. The Total row appears in the 
designer. 

3. In the field where you want to use the function, click the Total row and select a function 
from the list. 

4. When you run your query, the results include your calculation. 

Adding a Calculated Field in a Query 
Follow the steps below on how to add a calculated field in a query. 

1. Open the query in Design view. 

2. In the design grid, go to the first blank column, click the Field row, and enter your 
formula or expression. For example:Retire_Date: DateAdd('yyyy',5,[Acquired_Date]).  

3. Press CTRL+S to save your changes. 

4. On the Design tab, in the Results group, click Run. 

 

Student Activity 12.2.3.5 

Answer the following questions. 

1.   What is the importance of using a parameter in a query? 

 _______________________________________________________________________

 _______________________________________________________________________

 _______________________________________________________________________

 ______________________________________________________________________ 



              

              GR 12 ICT M2 DATABASE 2 

 

 111 

 

2.   Enumerate the steps in creating a query asking for an input. 

 _______________________________________________________________________

 _______________________________________________________________________

 _______________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________ 
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12.2.3.6  Running Queries 

A query is a set of instructions that you can use for working with data. You run a query to 
perform these instructions. In addition to returning results – which can be sorted, grouped or 
filtered – a query can also create, copy, delete, or changed data. 

You cannot run action queries if a database is operating in Disabled mode – a reduced 
functionality mode that Access uses to help protect your data in certain circumstances.   

Run a select or a crosstab query 
You use select queries and crosstab queries to retrieve and present data, and to supply forms 
and reports with data. Follow the steps below on how to run a select or crosstab query. 

1. Locate the query in the Navigation Pane. 

2. Do one of the following: 

 Double click the query you want to run. 

 Click the query you want to run, and then press ENTER. 

If the query you want to run is currently open in Design view, you can also run it by clicking 
RUN in the Results group on the Design tab on the Ribbon. 

Run an action query 
There are four types of action queries: append queries, delete queries, update queries, and 
make-table queries. Except for make-table queries (which create new table), action queries 
make changes to the data in tables they are based on. These changes cannot easily be 
undone, for example, by pressing CRTL + Z. If you make changes using an action query that 
you later decide you did not want to make, usually you will have to restore the data from a 
backup copy.  For this reason, you should always make sure you have a fresh backup of the 
underlying data before running an action query. 

You can lessen the risk of running an action query by first previewing the data that will be 
acted upon. There are two ways to do this; 

  View the action query in Datasheet view before you 
run it. To do this, open the query in Design View, 
click View on the Access status bar, and then click 
Datasheet View on the shortcut menu. 

  Change the query to a select query, and then run it. 

Run an action query as a select query 
Follow the steps below on how to run an action query as a select query. 

1. Open the action query in Design View. 
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Though the Total row cannot be deleted or cut, it can be hidden by clicking Totals 
on the Home tab. 

2. On the Design tab, in the Query Type group, click Select. 

3. On the Design tab, in the Results group, click Run. 

Using the Total Row in a Query 
A Totals row helps you see, at a quick glance, what the totals are for columns on a datasheet.  
For example, in a table of purchase information, we can show the sum of the price or units 
purchased, or a total count of the items by adding a Totals row to the datasheet. 

To show the Sum value for a column, the column’s data type has to be set to Number, 
Decimal or Currency.  For non-numeric columns, you can only select the Count total type. 

Add a Totals row 
Follow the steps below on how to add a Totals row. 
 
1. Double click the query from the Navigation Pane to open it in Datasheet View. 

2. On the Home tab, click Totals. 

3. For each cell in the Total row where you want a total to appear, click in the cell and select 
the kind of total you want. 

Once you are done with these steps, you will notice that a Total row has been added at the 
end of your datasheet. 

Selecting the total type 
After adding the Total row, you select what type of totals value is displayed for each column.  
For example, aggregates like sums can be displayed when the data type is set to Number, 
Decimal, or Currency.  A count of values is possible when the data type is a text value.  

 

 
 
 

Student Activity 12.2.3.6 

Answer the following questions. 

1.   What are the four types of an action query? 

 _______________________________________________________________________

 _______________________________________________________________________

 _______________________________________________________________________

 ______________________________________________________________________ 
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2.   How queries are presented when you run an action query? 

 _______________________________________________________________________

 _______________________________________________________________________

 _______________________________________________________________________

 ______________________________________________________________________ 

3.   How to add Totals row in a query? 

 _______________________________________________________________________

 _______________________________________________________________________

 _______________________________________________________________________

 ______________________________________________________________________ 

Summative Activity 12.2.3 

 
Answer the following questions. 

1. Identify what is being described in each of the statements below. 

a.  A small window that will display all the tables you choose to include in your query.  
It contains a list of every available field within the table.        
_______________ 

b. This is the command to view the results of the query in the table.  
_______________ 

c. It allows you to specify exactly what type of information you want your query to 
retrieve.                
_______________ 

d.  These are fields in the query that are located in the first row of the Design grid.   
                 
_______________ 

e. This part can be seen in the bottom part of the Query Design view.    
                 
_______________ 

2. Write True if the statement is correct otherwise write False if the statement is not true 
 on the space provided. 



              

              GR 12 ICT M2 DATABASE 2 

 

 115 

 

a. You can use queries to view, change and analyse data in different ways.  
__________ 

b. Query is a request to add an action on the data.           
__________ 

c. When you run a query, the results are presented to you in a form.            
__________ 

d. One way to create a simple query is to use the Query Wizard.                    
__________ 

e. The Query Design View will allow you to create a query that has full range of 
capabilities including filtering.                        
__________ 

f. Criteria are conditions that will determine which record will be included.    
                  
__________ 

g. You cannot set criteria for a query that can control how field information in 
selected fields appears in a completed query.                      
__________ 

h. The Query Design View allows you to remove the table fields you want in your 
query.                              
__________ 

i. You can insert, arrange and remove query fields.                    
__________ 

j. The Query Wizard is the easiest way to get started building multi-source queries, 
especially if you are new to Access.              
__________ 

  
Answers to Student Activity 12.2.3 

 

Answers may be similar to the ones below. 

Student Activity 12.2.3.1 

1.  Query is a simple search or filter that draws information from multiple tables.  It allows us 
to work in specific set of records that meet the criteria specified from a table in the 
database. 



 

                   GR 12 ICT M2 
DATABASE 2 

 

116  

 

2.  In creating a simple query you need to provide:  Fields need to be searched; search criteria 
or item that you are searching for; fields that you want to display with the results. 

3.  You can use Query Wizard to create a simple query.  Using this wizard will help the user to 
go through the process in a logical way.  Using this wizard also helps new users to create 
their own simple query. 

Practical Activity  

The following are the steps on how to create query using Query Wizard.   

1. Open the Sales Representative table you have created from the previous lesson. 

2. On the Create tab, click the Query Wizard.  

 
 
 
 
 
 
 
 
3. On the New Query dialog box, click the Simple Query Wizard and click OK. 

 

 

 

 

 

 

 

 

4. When the Simple Query Wizard opens, click the down arrow to select the table or other 
query from which you want to select fields. 

Choose Simple Query Wizard 
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5. Click a field and click the right arrow to move the field to the selected Fields list.  You can 

click the double arrow to move all the fields at once. 

 

 

 

 

 

 

 

 

 

6. You can pull as many fields as you want. 

7. Click Next. 

8. Type a name for the query and click Finish.  The query results will now appear in the 
datasheet.  Your output may be similar to the one below.  

 

 

 

Click arrows to 

select fields. 
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Student Activity 12.2.3.2 

1.  a.  The function of Query command is to draw information from multiple tables.  
  Queries allow the user to work on a specific set of records that meet the criteria  
  which are specified on the table. 

 b.  We can create a simple query by using Query Wizard. This wizard does steps  
  through the query design process in a logical way. This is the best way for starters.  
  On the other hand you can also create a query using Query Design view. This will 
  allow you to create a query that has full range of capabilities including filtering. 

2.  A.  For this activity, follow the steps below: 

a. Open the Students table. 

b. On the Create tab, click the Query Wizard.  

c. On the New Query dialog box, click the Simple Query Wizard and click OK. 

d. When the Simple Query Wizard opens, click the down arrow to select the table or 
other query from which you want to select fields. 

e. Click a field and click the right arrow to move the field to the selected Fields list.  You 
can click the double arrow to move all the fields at once. 

f. You can pull as many fields as you want. 

g. Click Next. 

h. Type a name for the query and click Finish. 

i. The query results will now appear in the datasheet. 

B.  For this activity, follow the steps below: 

a. Open the Customer’s table. 

b. Click the Create tab, and in the Queries group, click Query Design. 

c. In the Show Table dialog box, click the table you want to use, click Add, and then 
click Close to close the dialog box. 

d. In the table, double-click the fields you want to use in the query.  
Notice that the fields appear in the grid at the bottom of the designer. You can also 
drag fields from the table to an empty column in the grid. 

e. On the Design tab, in the Results group, click Run. 

f. The query loads the data into a datasheet. 



              

              GR 12 ICT M2 DATABASE 2 

 

 119 

 

g. Press CTRL+S to save the query, and in the Save As dialog box, enter a name. 

 

Student Activity 12.2.3.3 

Arrange the following steps: 
I.  To remove a field in a query.  Use numbers 1 to 3 

2 

1 

3 

II. To insert a field in a query.  Use numbers 1 to 4 

3 

1 

4 

2 

III. To move a field in a query.  Use numbers 1 to 3 

2 

3 

   1 

 

Student Activity 12.2.3.4 

A.   

1.  The function of Query command is to draw information from multiple tables. Queries allow 
the user to work on a specific set of records that meet the criteria which are specified on 
the table. 

2.  We can create a simple query by using Query Wizard. This wizard does steps through the 
query design process in a logical way. This is the best way for starters. On the other hand 
you can also create a query using Query Design view. This will allow you to create a query 
that has full range of capabilities including filtering. 



 

                   GR 12 ICT M2 
DATABASE 2 

 

120  

 

B. 

1.  For this activity, follow the steps below: 

a. Open the Students table. 

b. On the Create tab, click the Query Wizard.  

c. On the New Query dialog box, click the Simple Query Wizard and click OK. 

d. When the Simple Query Wizard opens, click the down arrow to select the table or 
other query from which you want to select fields. 

e. Click a field and click the right arrow to move the field to the selected Fields list. You 
can click the double arrow to move all the fields at once. 

f. You can pull as many fields as you want. 

g. Click Next. 

h. Type a name for the query and click Finish. 

i. The query results will now appear in the datasheet. 

2.  For this activity, follow the steps below: 

a. Open the Customer’s table. 

b. Click the Create tab, and in the Queries group, click Query Design. 

c. In the Show Table dialog box, click the table you want to use, click Add, and then 
click Close to close the dialog box. 

d. In the table, double-click the fields you want to use in the query. Notice that the fields 
appear in the grid at the bottom of the designer. You can also drag fields from the 
table to an empty column in the grid. 

e. On the Design tab, in the Results group, click Run. 

f. The query loads the data into a datasheet. 

g. Press CTRL+S to save the query, and in the Save As dialog box, enter a name. 

 

 

 



              

              GR 12 ICT M2 DATABASE 2 

 

 121 

 

Student Activity 12.2.3.5 

1.  Parameters in a query will limit the data that will return to the user. It makes the query to 
ask input before it runs. Parameters will provide simplicity and straight to the point data to 
user. 

2.  The steps in creating a query asking for an input are as follows: 

Open the query in Design view, and in the Criteria row of the field that you want to 
filter, enter your parameter. For example, you can use the criteria such as: Between 
[Start Date] And [End Date].   

When you run the query, that criteria asks you for a start date, then an end date, and it 
returns only the records that fall within the dates you specify. 

 

Student Activity 12.2.3.6 

1.  The four types of action queries are delete queries, append queries, update queries and 
make-table queries 

2.  After a query has been designed, as you click on the Run Query command, result will be 
displayed in a table. 

3.  To add totals in a row: double click the query from the Navigation Pane to open it in 
Datasheet view. On the Home tab, click totals. For each cell in the Total row where you 
want a total to appear, click in the cell and select the kind of total you want. 

 

Answers to Summative Activity 12.2.3 

 

1.   

a.   Object Relationship Pane  b.   Run Query 

c.   Query Criteria    d.   Field and Table Names 

e.   Design Grid 

2.   

a.   True      b.   False 

c.   False      d.   True 
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e.   True      f.   True 

g.   False      h.   False 

i.   True      j.   True 

 

12.2.4    Creating and Customising Forms and Reports 

12.2.4.1   Creating Forms Effectively 

Access forms are much like paper forms: you can use them to enter, edit, or display data. They 
are based on tables. When using a form, you can choose the format, the arrangement, and 
which fields you want to display. 

A form is a type of database object that is used to enter, change, delete and display in a 
database. A form can contain line, colour and images together with check boxes, button and 
other features called controls. When you create a form, there are a couple of key purpose 
that you should keep in mind. Your form is good at its job if it achieves clarity and control. 

Forms help people focus on just what they need when they enter or view data. You should 
design a form so that it is easy to read and understand.  Access can automatically create 
several types of forms. For example, when you click the Form button on the Create Tab, 
Access places all fields in the selected table on a form. If the table has a one-to-many 
relationship with one other table or query, Access creates a stacked form (the records are 
displayed in a column) for the primary table and a datasheet for the related table. If there are 
several tables with a one-to-many relationship, Access does not create the datasheet. 

Why are Forms important? 
Forms allow you to display data in a more presentable form than a datasheet can. It also 
allows you to see all the fields at once, or just some of the fields. It can also allow you to 
generate other data from the existing data, like showing calculation from figures on the form. 
Forms allow more functionality by having controls such as buttons. It can link into queries and 
can set up subforms to present data in relationships.   

Creating a Form using an Auto Form 
Auto Forms are the forms that come with the Office while installing 
it. There will be some pre-created forms that will come with 
Microsoft Access by default. You can quickly build forms by using 
the AutoForm feature. The AutoForm feature gives you absolutely 
no control over how a form appears, but it provides you with an 
instantaneous means of data entry.   

Creating a form using the AutoForm feature is amazingly easy.  
Here is how it works: 

1. Select the table or query on which you want to base the new 
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form.   

2. Select Form in the Form group on the Create tab of the Ribbon. Access creates a form 
based on the selected table or query. 

 
 
 
 
 
 

Creating a Basic Form 
You can create forms either from the Form Wizard from the Design View. You can also create 
three types of forms – plain form, split form that shows both datasheet and form at the same 
time; multiple-item form that shows multiple records at the same time. 

Follow the steps below on how to create a basic form. 

1. On the Objects list, click the table or query you want to use.  Open Customers table. 

2. On the Create tab, click Form.  

 

 

Access creates the form and displays it in Layout view. In Layout view, you can make design 
changes to the form while it is displaying data. For example you can adjust the size of the text 
boxes to fit the data. 

3. To begin working with the form, switch to form view. 
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Form Sections 
The following are the sections of a Form: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
1. Form Header displays information that remains the same on each record (for example, 

the title of the form). 

2. Detail displays the record. 

3. Form Footer displays information that remains the same on each record (for example, 
the instructions on how to use the form.) 

After you have created a form, the following tabs will appear: 

1. From the Layout Tools Design. 

 
 
 
 
 
 
 
 

2. From the Layout Tools Arrange. 

1 

2 

3 
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3. From the Layout Tools Format. 
 

Creating a Split Form 
Follow the steps below on how to create a Split Form: 
 
1. On the Objects Pane, click the table or query that you want to use.  Let us use the table 

which you have created named Customers. 

 

 

 

 

 

 

 

2. On the Create tab, click More Forms. 

 

 

 

 

 

 

 

 

3. Click the arrow down and choose Split Form. 
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4. The form is displayed on the upper part of the screen and the datasheet is on the lower 
part. If Access finds a table that has a one-to-many relationship with the table or query 
that you used to create the form, Access adds a subdatasheet to the form that is based 
on the related table or query.   

Adding Fields to a Form 
When you use the Form command on an existing table, all of the fields from that table are 
included in that form. However, if you later add additional fields to that table, those fields will 
not automatically show up in existing forms. In situation like this, you can add additional fields 
to a form.  

Follow the steps below on how to add fields to a Form.  You can use any of the table you have 
created in the previous lessons.   

1. Select the Form Layout Tool Design tab, and then locate the Tools group on the right 
side of the ribbon. 

 

 

 

 

2.  Click the Add existing Fields command. 

3. The Field List pane will appear.  Select the field or fields to add to your form. 

 

 

 

 

 

 

 

 

 
 
 
 



              

              GR 12 ICT M2 DATABASE 2 

 

 127 

 

Saving Forms 
Although Access automatically saves all the data changes that you make to a form, it is up to 
you to save all the design changes that you make to the form. As you work with the design of 
a form, you should periodically click Save tool on the Quick Access toolbar to save changes. 
When you close the form, Access prompts you to once again save your changes. Follow the 
steps below on how to save Forms. 

1.   On the Quick Access Toolbar, click the Save button. 

 

 

 

OR 

1.   You can also right click on the form tab and select Save on the context menu. 

 

 

 

 

 

 

 

3.   When the Save As dialog box appears, type your file name. 

                Student Activity 12.2.4.1    

Follow the instructions below. 

A. Briefly answer the following questions. 

 
1. What is a form? 
 ________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________ 

Click the Form tab. 
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2. How do you create a Split Form? 
a._______________________________________________________________________ 

b.______________________________________________________________________ 

c._______________________________________________________________________ 

d.______________________________________________________________________ 

e._______________________________________________________________________ 

3.  List the six basic types of forms. 
a.______________________________________________________________________ 

b.______________________________________________________________________ 

c._______________________________________________________________________ 

d.______________________________________________________________________ 

e.______________________________________________________________________ 

f._______________________________________________________________________ 

 

B. Create an Animals table that contains the following:  Name of animal, 

type, food and shelter.  With this table create a form using AutoForm. 
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12.2.4.2   Customising Forms 

When working with forms you will probably need to customise the form to improve the look 
function.  You can use Access Design View to add additional efficiency to your forms. 

You can add, delete and make changes in the form you have created. You can also change the 
font, size and style of text in the text box. 

These setting adjustments take place via the handy Property Sheet. To make adjustments, you 
need to access the Property Sheet. To do this, follow the steps 
below: 

1. Open any Table or Query you created from the previous 
lesson. 

2. Click on the View in the toolbar at the top left of the 
program window. 

3. Once in Layout View, click on the Design tab. 

 

 

4. On the right-hand side you should see the Property Sheet Option in the Tools section. 
 
 
 
 
 
 
 
 
 
5. Click on it to display the Property Sheet and all of its settings. 
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Within the Property Sheet are multiple tabs that you can go to in order to adjust different 
settings. These tabs include Format, Data, Event, Other, and All. As for the settings in these 
tabs, they are displayed with the property name in the left column of each row and the 
property value in the right column. 

Adjusting each property can be done in one of the two 
ways. Some of the properties will ask you to enter a 
desired value, while others will have convenient drop-
down menus with a list of pre-defined values for you to 
choose from. 

Now that you know how to access the Property Sheet 
and all the adjustable properties and settings it contains. 
Let us start making adjustments. For our sample form, 
we are going to begin by hiding the first field in the 
form, the ID field. Open the form you have just created 
from previous exercises and follow the steps below. 

1. Select ID field in the form by clicking on it. 

2. Go over the Property Sheet and click on the 
Format tab.  Look down for the Format property 
labeled Visible. 
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3. The default value of this property is Yes.  We do not want it to be visible, however, so 
click on it to display the drop-down menu, and click No. 

4. To see the result of the changes we just made, click on View at the top left of the 
program window and select Form View. Looking at the form, you should see that ID is no 
longer visible.  

You can make this property visible again by going to the Visible Property in the Format tab of 
the property Sheet and selecting the Yes option. 

 
Adding additional fields to a Form 
When you use the Form command on an existing table, all of the fields from that table are 
included in that form. However, if you later add additional fields to that table, those fields 
will not automatically show up in existing forms. In situations like this, you can add additional 
fields to a form. 

1. Select the Form Layout Tools Design tab, and then locate the Tools group on the right 
side of the Ribbon. 

2. Click the Add Existing Fields command. 

 

 

 

 

3.  The Field List pane will appear. Select the field or fields to add to your form. 

 If you want to add a field from the same table you used to build the form, 

simply double-click the name of the desired field. 
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 To add a field from a different table: 

1. Click Show All Tables. 

 

 

 

 

2. Click the plus sign + next to the table containing the field you wish to add. 

3. Double-click the desired field. 

 

 

 

 

 

 

 

4.  The new field will be added. 

You can also use the above procedure to add fields to a totally blank form. Simply create a 
form by clicking the Blank Form command on the Create tab, and then follow the above 
steps to add the desired fields. 
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Student Practical Activity 12.2.4.2    

 

1.  Create a Form using the Animal Table you have previously created.   

2.  Add the following fields to your Form: 

a. Scientific Name,  

b. Type of animal 

c. Country where to find the animal. 

3.  Insert the new fields in the Form. 

After creating a form, you might want to modify its appearance. Formatting your form can 
help make your database look consistent and professional. Some formatting changes can even 
make your forms easier to use.   

Access offers many options that allows you make your forms look exactly the way you want.  
While some of these options, like command buttons, are unique to forms, others may be 
familiar to you. 

Designing Forms 
You can set and change the Theme, Theme colour and Theme fonts. You can also add text 
boxes, check boxes, list boxes and other objects in your form with the use of the tools 
available in the Form Layout Tools Design tab. 

 
Arranging Forms 
To resize and rearrange our fields the way we want, we need to modify the form layout. For 
instance, since the default layout for our form contains only two columns – one for the field 
labels and the other for the fields – we would have to create a new column to put two fields 
side by side. We can do this by using the command on the Arrange tab, which contains all of 
the tools you need to customise your form’s layout. 
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To resize Form components 
Follow the steps below to resize Form components: 

1. Switch to Layout view. 

2. Select the field or button you would like to resize, and hover your mouse over the edge. 
Your cursor will become a double-sided arrow. 

 

 

 

 

 

 

3.  Click and drag the edge to resize, and release when the field or button of the desired 

size. 

4.  The field or button, as well as every other item in line with it, will be resized. 
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Moving Form Components 
Follow the steps below to move Form components: 

1. If necessary, add columns or rows to make room for the field or button you wish to 
move by using the Insert commands in the Rows & Columns group. In our example, we 
want to move the Last Name field to the right of the First Name field, so we will have to 
create two new columns to the right: one for the field label, and the other for the field 
itself. To do this, we will click the Insert Right command twice. 

2. Click and drag the field or button to its new location. If you are moving a field, make 
sure to move the field label as well. 

 

3.  Repeat steps one and two with any other fields or buttons you wish to move. 
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 If you would like to make a field take up more or less space than one column, you can 
 make use of the Merge and Split command. The Merge command combines two or 
 more cells,  while the Split commands divides a cell. 

 
Formatting Forms 
You can set and change the Font type, size, colour, alignment and attributes of fonts in your 
form with the use of the tools available in the Form Layout tools Format tab. 

  
Adding a Graphic to a Form 
You can add graphic images to a form such as logos, clip art or pictures. 
Follow the steps below on how to add graphic to a Form: 

1. After creating your form, click the Format tab. 

2. Click the Background Image button. 

3. Click Browse and from the Insert Picture dialog box, select the file 
where your picture is saved. 
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4. Click Open. 

 

Student  Practical Activity 12.2.4.2    

Using the Animal Table and with the form you have just created, perform the 
following:  

1. Design your form, rearrange some of the fields, and add graphics to your form.   

2. You may apply the knowledge you have learned from the previous lesson. You are free 
to design and format your own form. 
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12.2.4.3      Using Auto Report and Report Wizard 

Reports allow you to present, organise, summarise and print all or part of the data in a 
database. You can create report from the Datasheet view, from the Report Database Object or 
from the Report Wizard. You can use the design tools to bring together data, charts, 
illustrations, audios and videos. You can also enhance your report with color and within 
different fonts. 

Reports are the end product of your database. They combine the raw facts in your database 
with enough information to give those facts meaning, and they present the results visually. 
For example, if you need to use charts or graphs, you use a report. Reports are also the best 
way to format and print your data, and they are a good way to summarise data. For example, 
you can group your assets by supplier and calculate a subtotal for each group, as well as a 
grand total for all groups. 

In Access, a report is made up of the following sections. 

1. Header sections can appear at the top of a report, or in the case of Page Header 
sections, at the top of each page in the report. Report headers usually contain titles, and 
images such as company logos. Page headers usually contain column headings. 

2. If you want to group the data in a report, you will see a Group Header. The section will 
list the fields on which you group your data. For example, if you need to see who repairs 
a given computer, you can group your data by repair technician. 

3. The Detail section is the body of your report, the data your users need to see. All reports 

must have a detail section. 

4. Footer sections can appear in several places. For example, you can create group footers 
that display sums, counts, or averages for a group of data. You can also create page 

1 

2 

3 

4 
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footers that appear at the bottom of each report page and display elements such as 
page numbers. 

The header and footer sections are optional. For example, if you do not want to group your 
data, you do not need group headers or footers. However, make sure your reports contain 
enough information to make them meaningful and easy to understand. 

Designing your Report 
So how do you make your reports meaningful and easy to understand with a design? Start by 
deciding on the data you need to include in the report, and then on the sections you want in 
the report. For example, all reports need a detail section, but do you need a header? How 
about grouping? From there, you decide on a layout. Access provides two basic layouts – 
tabular and stacked – but you can arrange your data in almost any way you want. 

1. Tabular layouts resemble spreadsheets. Use them when you need to present your data 
in a simple list format. 

2. Stacked layouts resemble the forms you fill out at a bank or when you buy something 
online. Use a stacked layout if your report contains too many fields to display in tabular 
form. 

3. Mixed layouts use elements from tabular and stacked layouts. For example, you can 
place some of the fields in a record on the same row, and stack other fields from the 
same record. In Access 2010, you create mixed layouts manually, using either Layout 
view or Design view. 

After you finish your design, you have several options for creating the report. We will start 
with the Report tool. 

Creating a Simple Report 
You can generate a report quickly, save it or just re-create it the next time you want to use it. 
Follow the steps below on how to create a simple report: 

1. Click the table or query that you want to create a 
report. 

2. On the Create tab, click Report and the report 
appears in the Layout view.  This view gives you a 
chance to change it.  For example, you can resize a 
field by clicking and dragging a single control, or you 
can switch to a stacked layout 

3. Click the save button and type your file name to save the report. 
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Creating Reports from the Report Wizard 
You can use the Report Wizard to easily create and format your report. Using Report Wizard 
helps you to be more selective about what fields appear on your report. You can also specify 
how the data is grouped or sorted, and you can use fields from more than one table or query, 
provided you have specified the relationships between the tables and queries beforehand. 
Follow the steps on how to create a Form using the Report Wizard: 

1. On the Create Tab, in the Reports group, click Report Wizard. 

2. On the Report Wizard Dialog box, click the down arrow to select a table or query where 
the report will be based. 

 

 

 

 

 

 

 

3. Select a field and click the right arrow to move the selected field to the Selected Field 
lists.  Repeat this step if you want more fields to be included in the Selected Fields list. 
Use the double right arrow to select all fields.  Use the left arrow to deselect the field. 

4. Click Next. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
5. Click a field by which you want to group. 
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6. Grouping a report allows you to break it into parts based on the contents of a field. You 
can group the report by category. Select the field you want grouped. You use more than 
one field, but you must prioritise and determine what category you want first, second 
and so on. 

7. Click the right arrow to group the chosen field. 

8. Click Next. 

9. Click the down arrow to choose a field by which you want to sort. 

10. Sorting goes side by side with grouping. You can specify the field by which the report will 
be sorted. You can also sort by multiple fields. You can group a report by category and it 
will be listed alphabetically in ascending or descending order. 

11. Select between Ascending and Descending sort level. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
12. Click Next. 

13. Click the radio button of the layout you want to use. The layout option allows you to 
choose the data arrangement on the page. You can choose from Stepped, Block or 
Outline. 

14. Click the radio button of the page orientation you want to set. You can choose between 
Portrait or Landscape. 
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15. Click Next. 

16. Click the name for your report. You can use the generic name or change it to another 
name. 

17. Click the radio button if you want to Preview the Report (view will be Print Preview) or 
Modify the Report Design (view will be Design view). 

18. Click Finish. 

If you want to include fields from multiple tables and queries in your report, do not 
click Next or Finish, after you have selected the fields from the first table or query 
on the first page of the Report Wizard. Instead, repeat the steps to select a table or 
query, and click any additional fields that you want  in the report. 

 
 
Student Practical Activity 12.2.4.3    
 
 
 

Open the Customers table you have created from the previous activity. Create a Report 
using Report Wizard. 
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12.2.4.4      Creating Report in Layout or Design View 

The report can be designed in Layout view or Design view. Layout view works best when you 
need to change the look and feel of a report. For example, you can rearrange fields, change 
their sizes, or apply a pre-made style. 

You can start with the Layout view and switch to design view. Follow the steps below on how 
to create a Report: 

1. On the Create tab, click Blank Report. 

2. On the Blank Report window in the Layout view, click the Show all tables from the Field 
list. 

3. Click the plus sign + to expand the field list. 

4. Drag the field onto the report. 

As done for a form, in the Design View of a report, you can add, position, format, configure 
and manipulate the necessary controls. The Design View is equipped with one or more 
sections.  Design view gives you control over every facet of your report. For example, you can 
add text boxes that display the date and time that you ran a report. 

As mentioned when studying Form or Report design, when a report is in Design View, the 
Ribbon is equipped with Control section in its Design tab. You can use these controls to 
populate your report. You can also select objects from the Field List and add them to the 
report. 

Subtotals and percentages usually have more meaning if you label them. You can do that job 
in Layout view or Design view. These steps use Design view, but remember you cannot use 
Design view if you are working on a web database. Follow the steps below on how to add a 
label: 

1. In the Navigation pane, right-click the report and click Design View. If the report is 
already open, right-click the document tab for the report and click Design 
View. 

2. Locate the control to which you want to add a label, go to the Design tab, in 
the Controls group, and click Label.  

 
 How the cursor changes to a plus sign and a capital A. You use the plus sign as your 
reference mark when you draw your label. 
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3. Click the area where you want to add the label, and drag to draw 
the label. Make the label wider than shown in the picture — give 
yourself room to type. 

4. When you finish dragging, the label becomes available for writing. 
Enter your text, then click anywhere outside the label to commit 
your changes. 

5. Save your changes. 

Modifying a Report 
The report can be modified using Design view, where the structure of the report can be seen. 
Follow the steps below on how to modify a Report: 

1. Select the report you want to modify. 

2. On the Design tab, click View and select Design View. 

3. The Ribbon will show four tabs: Design, Arrange, Format and Page Setup.  These tabs 
contain tools that will allow you to modify and design your report. 

Modifying the Layout 
You can select the report layout – tabular which looks like a table or stacked which shows 
each record in a separate section. Follow the steps on how to modify the layout: 

1. Go to the Arrange tab. 

2. Click Tabular or Stacked button. 

Modifying the Font 
You can change the font type, size, colour and attributes. Follow the steps below on how to 
modify the font. 

1. On the Design tab, click View and select Layout View. 

2. Click the label or field that you want to format. 

3. On the Format tab, click the Font down arrow and select from the list of available fonts. 

4. Click the Size down arrow and select from the list of available sizes or type your own 
size. 

5. Click the Font Colour down arrow and select from the gallery of colours. 

6. Click Bold, Italics or Underline buttons to change the attributes. 
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Adjusting the Alignment of Report Fields 
You can adjust the alignment and size of the fields or labels in the report. Follow the steps on 
how to adjust the alignment of Report Fields: 

1. On the Design tab, click View and select Layout view. 

2. Point your mouse over the right edge of the cell and when a double-sided arrow 
appears, drag the mouse to resize. 

3. On the Design tab, click View and select Design View. 

4. On the Arrange tab, click Align and select To Grid, Left, Right, Top or Bottom. 

 
Student Activity 12.2.4.4   

Answer the following questions. 

1.   What are the two views Reports can be designed in? 

  

  

  

  

2.   Enumerate the things you can do a report when working in Design view. 

  

  

  

  

3.   What view can you modify your report?  Explain further your answer. 
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12.2.4.5      Working with Controls 

Controls are objects that display data, perform actions, and let you view and work with 
information that enhances the user interface, such as labels and images. Access supports 
three types of controls: bound, unbound, and calculated. 

 Bound control - a control whose source of data is a field in a table or query is a bound 
control. You use bound controls to display values from fields in your database. The 
values can be text, dates, and numbers, Yes/No values, pictures, or graphs. A text box 
is the most common type of bound control. For example, a text box that displays an 
employee's last name might get this information from the Last Name field in the 
Employees table. 

 Unbound control - a control that does not have a source of data (a field or expression) 
is an unbound control. You use unbound controls to display information, lines, 
rectangles, and pictures. For example, a label that displays the title of a report is an 
unbound control. 

 Calculated control - a control whose source of data is an expression rather than a field 
is a calculated control. You specify the value that you want in the control by defining 
an expression as the source of data for the control. An expression is a combination of 
operators (such as = and + ), control names, field names, functions that return a single 
value, and constant values. For example, the following expression calculates the price 
of an item with a 25 percent discount by multiplying the value in the Unit Price field by 
a constant value (0.75). 

An expression can use data from a field in the report's underlying table or query, or from a 
control in the report. 

When you create a report, it is probably most efficient to add and arrange all the bound 
controls first, especially if they make up the majority of the controls on the report. You can 
then add the unbound and calculated controls that complete the design by using the tools in 
the Controls group on the Design tab. 

You bind a control to a field by identifying the field from which the control gets its data. You 
can create a control that is bound to the selected field by dragging the field from the Field 
List pane to the report. The Field List pane displays the fields of the report's underlying table 
or query. To display the Field List pane, on the Design tab, in the Controls group, click Add 
Existing Field. 

Alternatively, you can bind a field to a control by typing the field name in the control itself or 
in the box for the ControlSource value in the control's property sheet. The property sheet 
defines the characteristics of the control, such as its name, the source of its data, and its 
format. 
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Using the Field List pane is the best way to create a control for two reasons: 

 A bound control has an attached label, and the label takes the name of the field (or the 
caption defined for that field in the underlying table or query) as its caption by default, 
so you do not have to type the caption yourself. 

 A bound control inherits many of the same settings as the field in the underlying table or 
query (such as for the Format, DecimalPlaces, and InputMask properties). Therefore, 
you can be sure that these properties for the field remain the same whenever you 
create a control that is bound to that field. 

If you already created an unbound control and want to bind it to a field, set the 
control's ControlSource property to the name of the field. 

Adding Controls to the Report 
Some controls are created automatically, such as the bound text box control that is created 
when you add a field from the Field List pane to your report. Many other controls can be 
created in Layout view or Design view by using the tools in the Controls group on 
the Design tab. 

 You can determine the name of each tool by placing the mouse pointer over the 
tool and then reading the tooltip that appears. 

 

Creating Control using tools in the Control group 
Follow the steps below on how to create Control using tools in the Control group: 

1. Click the tool for the type of control that you want to add. 

2. Click on the report where you want the control to be located. 

3. If you do not position the control perfectly on the first attempt, you can move it by using 
the following procedures: 

a. Click the control to select it. 

b. Position the mouse pointer over the edge of the control until the pointer turns into a 
four-headed arrow . 

c. Drag the control to the location that you want. 

This procedure creates an "unbound" control. If the control is the type that can display data 
(for example, a text box or check box), you need to enter a field name or expression in 
the ControlSource property for the control before it will display any data.  
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Group and Sort Data 
One of the more powerful things you can do in a report is to group and sort your data. For 
example, if you want to know which supplier provided a given set of computers, then 
grouping your assets by supplier can give you that information quickly and easily. 

You can group tabular or stacked reports. Follow the steps below on how to group tabular or 
stacked reports: 

1. Open your report in Layout view, and on the Design tab, in the Grouping & Totals group, 
click Group & Sort. The Group, Sort, and Total pane appears below your report. 

2. In the pane, click Add a group, and then select the field by which you want to group your 
data. Access groups your data to reflect your choice. 

3. If you want to sort your data, click Add a sort, select a field, and again Layout view 
displays the changes made. 

You can add ten grouping levels to a report, and you can sort each level, if you want to. 
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12.2.4.6      Placing Calculation to your Report 

In addition to grouping and sorting, you can add subtotals, grand totals, and other calculations 
to your reports. For example, you can calculate how much you spent on a given model of desk 
or office chair. Follow the steps below on how to place a calculation to your Report: 

1. With your report still open in Layout view, start the Group, 

Sort, and Total pane. 

2. Click a grouping level, and then click More. 

3. Locate the “totalled” field and click the arrow next to it. 

4. Use the Totals dialog box to select the field you want to 

calculate, the type of calculation you want to use, such as 

a sum or average, and to set options such as subtotals and 

grand totals. 

When you finish, your report displays the calculations. 

Printing a Report 
You can print a report from the Print Preview. Follow the steps below on how to print a 
Report: 

1. On the Print Preview tab, click Print. 

2. On the Print dialog box, adjust the printing settings such as Printer, Print Range, 
Number of Copies and other settings you want to make. 

Student Activity 12.2.4.6  
 

Answer the following questions. 

1.   What are controls? 

  

  

  

  

2.   Differentiate the three (3) types of Controls in your own words. 
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Summative Activity 12.2.4 

Answer the following. 

1. True or False.  Write True if the statement is correct otherwise write False if the 
 statement is not correct. 

a. You can use table to view, change and analyse data in different ways.   __________ 

b. Form is a request to add an action on the data.       __________ 

c. When you run a form, the result are presented to you in a form.    __________ 

d. One way to create a simple form is to use the Form Wizard.    __________ 

e. The Form Design View will allow you to create a form that has full range of capabilities 
 including filtering.           __________ 

f. Criteria are conditions that will determine which record will be included.  __________ 

g. You cannot set criteria for a form that can control how field information in selected 
 fields appears in a completed form.         __________ 

h. The Form Design View allows you to remove the table fields you want in your form.   
               __________ 

i. You can insert, arrange and remove form fields.      __________ 

j. The Form Wizard is the easiest way to get started building multi-source queries, 
 especially if you are new to Access.         __________ 

2. Identify what is being described in each statement below. 

a.   These are fields in the form that are located in the first row of the Design grid.   
           ____________________ 

b.  A small window that will display all the tables you choose to include in your form.  It 
contains a list of every available field within the table.     ____________________ 

c.  This is the command to view the results of the form in the table.     
           ____________________ 
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d.  It lets you specify exactly what type of information you want your form to retrieve.   
           ____________________ 

e.  This part can be seen in the bottom part of the Form Design view.      
           ____________________ 

  
Answers to Student Activity 12.2.4 

 

Answers may be similar to the ones below. 

Student Activity 12.2.4.1 

1.  Query is a simple search or filter that draws information from multiple tables. It allows us 
to work in specific set of records that meet the criteria specified from a table in the 
database. 

2.  In creating a simple query you need to provide: Fields need to be searched; search criteria 
or item that you are searching for; fields that you want to display with the results. 

3.  You can use Query Wizard to create a simple query. Using this wizard it will help the user 
to go through the process in a logical way.  Using this wizard also helps new user to create 
their own simple query. 

 

Student Activity 12.2.4.2 

1.   

a. The function of Query command is to draw information from multiple tables. Queries 
allow the user to work on a specific set of records that meet the criteria which are 
specified on the table. 

b. We can create a simple query by using Query Wizard. This wizard does steps through the 
query design process in a logical way.  This is the best way for starters. On the other 
hand, you can also create a query using Query Design view. This will allow you to create 
a query that has full range of capabilities including filtering. 

2. A.  For this activity follow the steps below: 

a. Open the Students table. 

b. On the Create tab, click the Query Wizard.  

c. On the New Query dialog box, click the Simple Query Wizard and click OK. 
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d. When the Simple Query Wizard opens, click the down arrow to select the table or 
other query from which you want to select fields. 

e. Click a field and click the right arrow to move the field to the selected Fields list.  You 
can click the double arrow to move all the fields at once. 

f. You can pull as many fields as you want. 

g. Click Next. 

h. Type a name for the query and click Finish. 

i. The query results will now appear in the datasheet. 

B.  For this activity, follow the steps below: 

a. Open the Customer’s table. 

b. Click the Create tab, and in the Queries group, click Query Design. 

c. In the Show Table dialog box, click the table you want to use, click Add, and then 
click Close to close the dialog box. 

d. In the table, double-click the fields you want to use in the query. Notice that the fields 
appear in the grid at the bottom of the designer. You can also drag fields from the 
table to an empty column in the grid. 

e. On the Design tab, in the Results group, click Run. 

f. The query loads the data into a datasheet. 

g. Press CTRL+S to save the query, and in the Save As dialog box, enter a name. 

 

Student Activity 12.2.4.3 

1. On the Create Tab, in the Reports group, 
click Report Wizard. 

2. On the Report Wizard Dialog box, click 
the down arrow to select a table or 
query where the report will be based. 

3. Select a field and click the right arrow to 
move the selected field to the Selected Field lists.  Repeat this step if you want more 
fields to be included in the Selected Fields list. Use the double right arrow to select all 
fields.  Use the left arrow to deselect the field. 
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4. Click Next. 
 
5. Click a field by which you want to group. 

6. Grouping a report allows you to break it into parts based on the contents of a field. You 
can group the report by category.  Select the field you want grouped. You use more than 
one field, but you must prioritize and determine what category you want first, second 
and so on. 

7. Click the right arrow to group the chosen field. 

8. Click Next. 

9. Click the down arrow to choose a 
field by which you want to sort. 

10. Sorting goes side by side with 
grouping.  You can specify the 
field by which the report will be 
sorted.  You can also sort by 
multiple fields.  You can group a 
report by category and it will be 
listed alphabetically in ascending 
or descending order. 

11. Select between Ascending and 
Descending sort level. 

12. Click Next. 

13. Click the radio button of the layout you want to use.  The layout option allows you to 
choose the data arrangement on the page.  You can choose from Stepped, Block or 
Outline. 

14. Click the radio button of the page orientation you want to set.  You can choose between 
Portrait or Landscape. 
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15. Click Next. 

16. Click the name for your report.  You can use the generic name or change it to another 
name. 

17. Click the radio button if you want to Preview the Report (view will be Print Preview) or 
Modify the Report Design (view will be Design view). 

18. Click Finish. 

 

Student Activity 12.2.4.4 

A.   

1.  The function of Query command is to draw information from multiple tables.  Queries 
allow the user to work on a specific set of records that meet the criteria which are specified 
on the table. 

2.  We can create a simple query by using Query Wizard.  This wizard does steps through the 
query design process in a logical way.  This is the best way for starters.  On the other hand 
you can also create a query using Query Design view.  This will allow you to create a query 
that has full range of capabilities including filtering. 

B. 

1.  For this activity, follow the steps below: 

a. Open the Students table. 

b. On the Create tab, click the Query Wizard.  

c. On the New Query dialog box, click the Simple Query Wizard and click OK. 

d. When the Simple Query Wizard opens, click the down arrow to select the table or 
other query from which you want to select fields. 
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e. Click a field and click the right arrow to move the field to the selected Fields list.  You 
can click the double arrow to move all the fields at once. 

f. You can pull as many fields as you want. 

g. Click Next. 

h. Type a name for the query and click Finish. 

i. The query results will now appear in the datasheet. 

2.  For this activity, follow the steps below: 

a. Open the Customer’s table 

b. Click the Create tab, and in the Queries group, click Query Design. 

c. In the Show Table dialog box, click the table you want to use, click Add, and then 
click Close to close the dialog box. 

d. In the table, double-click the fields you want to use in the query.  
Notice that the fields appear in the grid at the bottom of the designer. You can also 
drag fields from the table to an empty column in the grid. 

e. On the Design tab, in the Results group, click Run. 

f. The query loads the data into a datasheet. 

g. Press CTRL+S to save the query, and in the Save As dialog box, enter a name. 

 

Student Activity 12.2.4.5 

1.   Parameters in a query will limit the data that will return to the user.  It makes the query to 
ask input before it runs.  Parameters will provide simplicity and straight to the point data 
to user. 

2.   The steps in creating a query asking for an input are as follows: 

 Open the query in Design view, and in the Criteria row of the field you want to filter, enter 
your parameter. For example, you can use the criteria such as: Between [Start Date] And 
[End Date].   

 When you run the query, that criteria asks you for a start date, then an end date, and it 
returns only the records that fall within the dates you specify. 
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Student Activity 12.2.4.6 

1.  The four types of action queries are delete queries, append queries, update queries and 
make-table queries 

2.  After a query has been designed, as you click on the Run Query command, result will be 
displayed in a table. 

3.  To add totals in a row: double click the query from the Navigation Pane to open it in 
Datasheet view. On the Home tab, click totals. For each cell in the Total row where you 
want a total to appear, click in the cell and select the kind of total you want. 

Answers to Summative Activity 12.2.4 

 

1.   

a.   True 

b.   False 

c.   False 

d.   True 

e.   True 

f.   True 

g.   False 

h.   False 

i.   True 

j.   True 

2.   

a.   Object Relationship Pane 

b.   Form 

c.   Form Criteria 

d.   Field and Table Names 

e.   Design Grid 
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Summary  

Microsoft Access is a computer application used to create and manage computer-based 
databases on desktop computers and/or on connected computers (a network). Microsoft 
Access can be used for personal information management (PIM), in a small business to 
organize and manage data, or in an enterprise to communicate with servers. 

This module had presented the simple and essential content and skills in creating database 
using Access.  It provides adequate topics on how to build an Access database.  The concepts 
that have been covered in this module apply in general to all computer-based databases from 
the simplest form to advance queries and reports.  From planning to definition and setting up 
the database, telling the system what fields you need in each record.   

This module presented how Access is flexible and relatively offers a simple way to create 
databases to store, manage and enter data.  It even exceeds the capabilities of Excel.   

Upon completing this module, which provides detailed discussion on creating database Tables 
and Queries and obtaining its results through Forms and Reports it will provide an 
achievement of the following: 

 learned how to manage and control data within records 

 create and customise tables and queries in various ways 

 create and customise forms and reports in various views and ways 

 create and run advance queries 

 identify further uses of database with external data from other MS Office programs. 
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GLOSSARY  

A 

Access workspace. A workspace that uses the Access database engine to access a data source. 
The data source can be an Access database file, an ODBC database, such as a Paradox or 
Microsoft SQL Server database, or an ISAM database. 

Application background. The background area of an application window. 

Autoformat. A collection of formats that determines the appearance of the controls and 
sections in a form or report. 

AutoNumber data type. In an Access database, a field data type that automatically stores a 
unique number for each record as it is added to a table. Three kinds of numbers can be 
generated: sequential, random, and Replication ID. 

C 

Calculated control. A control that is used on a form, report, or data access page to display the 
result of an expression. The result is recalculated each time there is a change in any of the 
values on which the expression is based. 

Calculated field. A field, defined in a query, that displays the result of an expression rather 
than displaying stored data. The value is recalculated each time a value in the expression 
changes. 

Column. A location within a database table that stores a particular type of data. It is also the 
visual representation of a field in a datasheet and, in an Access database, the query design 
grid or the filter design grid. 

Column area. The part of PivotTable view that contains column fields. 

Column field. A field in the column area of PivotTable view. Items in column fields are listed 
across the top of a PivotTable list. Inner column fields are closest to the detail area; outer 
column fields are displayed above the inner column fields. 

Column selector. The horizontal bar at the top of a column. You can click a column selector to 
select an entire column in the query design grid or the filter design grid. 

Combo box.  A control used on a form that provides the combined functionality of a list box 
and a text box. You can type a value in a combo box, or you can click the control to display a 
list and then select an item from that list. 
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Command button. A control that runs a macro, calls a Visual Basic function, or runs an event 
procedure. A command button is sometimes called a push button in other programs. 

Current record. The record in a recordset from which you can modify or retrieve data. There 
can be only one current record in a recordset at any given time, but a recordset may have no 
current record — for example, after a record has been deleted from a dynaset-type recordset. 

D 

Data collection. A method of gathering information from users by sending and receiving 
HTML forms or InfoPath 2007 forms from Access 2007. In Access, you create a data collection 
request and send it to users in a form contained in an e-mail message. Users then complete a 
form and return it to you. 

Database application. A set of objects that can include tables, queries, forms, reports, 
macros, and code modules that are designed to work together to make a database easier to 
use. A database application is typically deployed to a group of users. 

Database objects.  An Access database contains objects such as tables, queries, forms, 
reports, pages, macros, and modules. An Access project contains objects such as forms, 
reports, pages, macros, and modules. 

DB2.  Is a database product from IBM.  It is a relational Database Management Systems.  DB2 
is designed to store, analyse and retrieve that data efficiently.  DB2 product is extended with 
the support of the Object-Oriented features and non-relational structures with XML. 

dBaseIII.  Is a database software, which means it manipulates data stored in a database.  It 
contains a large number of commands, operators, and functions that can perform the actions 
necessary to perform the work you want to do. 

F 

Field data types.  A characteristic of a field that determines what kind of data it can store. For 
example, a field whose data type is Text can store data consisting of either text or numeric 
characters, but a Number field can store only numerical data. 

Field List pane. A pane that lists all the fields in the underlying record source or database 
object. 

Field selector. A small box or bar that you click to select an entire column in a datasheet. 

Fill.  A report magnification that fills the Report Snapshot window by fitting either the width 
or the height of a page, depending on whether the report is in portrait or landscape 
orientation. 
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Filter.  A set of criteria applied to data in order to display a subset of the data or to sort the 
data. In Access, you can use filtering techniques, such as Filter By Selection and Filter By Form, 
to filter data. 

Filter area.  The part of a PivotTable view or PivotChart view that contains filter fields. 

Filter By Form. A technique for filtering data that uses a version of the current form or 
datasheet with empty fields in which you can type the values that you want the filtered 
records to contain. 

Filter By Selection. A technique for filtering records in a form or datasheet in which you 
retrieve only records that contain the selected value. 

Filter Excluding Selection. A technique in which you filter records in a form or datasheet to 
retrieve only those records that don't contain the selected value. 

Form. An Access database object on which you place controls for taking actions or for 
entering, displaying, and editing data in fields. 

Form footer.  Used to display instructions for using a form, command buttons, or unbound 
controls to accept input. Appears at the bottom of the form in Form view and at the end of a 
printout. 

Form header.  Used to display a title for a form, instructions for using the form, or command 
buttons that open related forms or carry out other tasks. The form header appears at the top 
of the form in Form view and at the beginning of a printout. 

Form object tab.  An object tab in which you work with forms in Design view, Form view, 
Datasheet view, or Print Preview. 

Form properties.  Attributes of a form that affect its appearance or behavior. For example, 
the DefaultView property is a form property that determines whether a form will 
automatically open in Form view or Datasheet view. 

Form selector.  The box where the rulers meet, in the upper-left corner of a form in Design 
view. Use the box to perform form-level operations, such as selecting the form. 

Form view.  A view that displays a form that you use to show or accept data. Form view is the 
primary means of adding and modifying data in tables. You can also change the design of a 
form in this view. 

Format. Specifies how data is displayed and printed. An Access database provides standard 
formats for specific data types, as does an Access project for the equivalent SQL data types. 
You can also create custom formats. 
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FoxPro.  Is a relational database procedural programming language.  It was originally 
developed by Fox Software and later merge with Microsoft in 1992. 

G 

Grid (Datasheet view).Vertical and horizontal lines that visually divide rows and columns of 
data into cells in a table, query, form, view, or stored procedure. You can show and hide these 
grid lines. 

Grid (Design view).An arrangement of vertical and horizontal dotted and solid lines that help 
you position controls precisely when you design a form or report. 

I 

Interbase.  Is a relational database management system currently developed and marketed by 
Embarcadero Technologies.  Interbase is distinguished from other RDBMS by its small 
footprint, close to zero administration requirements, and multigenerational architechture. 

L  - N 

Label. A control that displays descriptive text, such as a title, a caption, or instructions, on a 
form or report. Labels may or may not be attached to another control. 

Many-to-many relationship. An association between two tables in which one record in either 
table can relate to many records in the other table. To establish a many-to-many relationship, 
create a third table and add the primary key fields from the other two tables to this table. 

Microsoft Access data file.  An Access database or Access project file. An Access 2007 
database stores database objects and data in an .accdb file, and earlier versions of Access use 
the .mdb format. A project file does not contain data, and is used to connect to a Microsoft 
SQL Server database. 

Microsoft Access database. A collection of data and objects (such as tables, queries, or forms) 
that is related to a particular topic or purpose. 

Microsoft Access object.  An object, defined by Access, that relates to Access, its interface, or 
an application's forms and reports. In addition, you can use a Microsoft Access object to 
program the elements of the interface used for entering and displaying data. 

Microsoft Access project. An Access file that connects to a Microsoft SQL Server database and 
is used to create client/server applications. A project file doesn't contain any data or data-
definition-based objects, such as tables and views. 

Microsoft SQL Server. Is a relational database management system developed by Microsoft. 
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MySQL. Is an open source relational database management system.  It is based on the 
structure query language (SQL), which is used for adding, removing, and modifying 
information in the database.   

Navigation buttons.  The buttons that you use to move through records. These buttons are 
located in the lower left corner of the Datasheet view and Form view. The buttons are also 
available in Print Preview so that you can move through the pages of your document. 

Navigation Pane. The pane that appears when you open an Access database or an Access 
project. The Navigation Pane displays the objects in the database, and can be customized to 
sort and group objects in different ways. 

Null.  A value you can enter in a field or use in expressions or queries to indicate missing or 
unknown data. In Visual Basic, the Null keyword indicates a Null value. Some fields, such as 
primary key fields, can't contain a Null value. 

Null field. A field containing a Null value. A null field is not the same as a field that contains a 
zero-length string (" ") or a field with a value of 0. 

Number data type. In an Access database, a field data type designed for numerical data that 
will be used in mathematical calculations. Use the Currency data type, however, to display or 
calculate currency values. 

Numeric data type. In an Access project, an exact numeric data type that holds values from -
10^38 - 1 through 10^38 - 1. You can specify the scale (maximum total number of digits) and 
precision (maximum number of digits to the right of the decimal point). 

O - R 

Object data type.  A fundamental data type representing any object that can be recognized by 
Visual Basic. Although you can declare any object variable as type Object, it is best to declare 
object variables according to their specific types. 

Object type.  A type of object exposed by a program through Automation; for example, 
Application, File, Range, and Sheet. Use the Object Browser in the Visual Basic Editor or refer 
to the program's documentation for a complete listing of available objects. 

Object variable.  A variable that contains a reference to an object. 

One-to-many relationship. An association between two tables in which the primary key value 
of each record in the primary table corresponds to the value in the matching field or fields of 
many records in the related table. 
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One-to-one relationship. An association between two tables in which the primary key value 
of each record in the primary table corresponds to the value in the matching field or fields of 
one, and only one, record in the related table. 

Option button. A control, also called a radio button, that is typically used as part of an option 
group to present alternatives on a form or report. A user cannot select more than one option. 

Oracle (Oak Ridge Automatic Computer and Logical Engine). Is a powerful relational database 
management system that offers a large feature set.  It is widely regarded as one of the two 
most popular full-featured database systems on the market.  

Page footer. Used to display page summaries, dates, or page numbers at the bottom of every 
page in a form or report. In a form, the page footer appears only when you print the form. 

Page header. Used to display a title, column headings, dates, or page numbers at the top of 
every page in a form or report. In a form, the page header appears only when you print the 
form. 

Primary key.  One or more fields (columns) whose values uniquely identify each record in a 
table. A primary key cannot allow Null values and must always have a unique index. A primary 
key is used to relate a table to foreign keys in other tables. 

Query.  A question about the data stored in your tables, or a request to perform an action on 
the data. A query can bring together data from multiple tables to serve as the source of data 
for a form or report. 

Query window.  A window in which you work with queries in Design view, Datasheet view, 
SQL view, or Print Preview. 

Record navigation control.  A control used on a data access page to display a record 
navigation toolbar. In a grouped page, you can add a navigation toolbar to each group level. 
You can customize the record navigation control by changing its properties. 

Record number box. A small box that displays the current record number in the lower-left 
corner in Datasheet view and Form view. To move to a specific record, you can type the 
record number in the box, and press ENTER. 

Record selector. A small box or bar to the left of a record that you can click to select the 
entire record in Datasheet view and Form view. 

Relationship. An association that is established between common fields (columns) in two 
tables. A relationship can be one-to-one, one-to-many, or many-to-many. 

Relationships object tab.  An object tab in which you view, create, and modify relationships 
between tables and queries. 
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Report. An Access database object that that you can print containing information that is 
formatted and organized according to your specifications. Examples of reports are sales 
summaries, phone lists, and mailing labels. 

Report footer. A report section that is used to place information that normally appears at the 
bottom of the page, such as page numbers, dates, and sums. 

Report header. A report section that is used to place information (such as a title, date, or 
report introduction) at the beginning of a report. 

Report module. A module that includes Visual Basic for Applications (VBA) code for all event 
procedures triggered by events occurring on a specific report or its controls. 

Report object tab.  An object tab in which you work with reports in Design view, Layout 
Preview, or Print Preview. 

Report selector. The box where the rulers meet in the upper-left corner of a report in Design 
view. Use the box to perform report-level operations, such as selecting the report. 

Row selector. A small box or bar that, when clicked, selects an entire row in table or macro 
Design view or when you sort and group records in report Design view. 

S - T 

Section. A part of a form or report, such as a header, footer, or detail section. 

Section header. The horizontal bar above a form or report section in Design view. The section 
bar displays the type and name of the section. Use it to access the section's property sheet. 

Section selector. The box on the left side of a section bar when an object is open in Design 
view. Use the box to perform section-level operations, such as selecting the section. 

Sybase. Is a computer software company that develops and sells database management 
system.  

Tab control.  A control that you can use to construct a single form or dialog box that contains 
several pages, each with a tab, and each containing similar controls, such as text boxes or 
option buttons. When a user clicks a tab, that page becomes active. 

Table. A database object that stores data in records (rows) and fields (columns). The data is 
usually about a particular category of things, such as employees or orders. 

Table data type. In an Access project, a special data type that is used to store a result set in a 
local variable or return value of a user-defined function for later processing. It can be used in 
place of a temporary table stored in the tempdb database. 
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Table object tab.  In an Access database, an object tab in which you work with tables in 
Design view or Datasheet view. 

Table properties.  In an Access database, attributes of a table that affect the appearance or 
behavior of the table as a whole. Table properties are set in table Design view, as are field 
properties. 

Text box.  A control, also called an edit field, that is used on a form or report to display text or 
accept data entry. A text box can have a label attached to it. 

Text data type.  In an Access project, a variable-length data type that can hold a maximum of 
2^31 - 1 (2,147,483,647) characters; default length is 16. 

Text data type.  In an Access database, this is a field data type. Text fields can contain up to 
255 characters or the number of characters specified by the FieldSize property, whichever is 
less. 

Toolbox.  A set of tools that is available in Design view for adding controls to a form or report. 

ToolTips. Brief descriptions of the names of commands and buttons on the Ribbon. A ToolTip 
is displayed when the mouse pointer rests on these commands and buttons. 

X 

Xbase.  Is the generic term for all programming languages that derive from the original dBase 
programming language and database formats.  These are sometimes informally known as 
dBase “clones.” 
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FODE SUBJECTS AND COURSE PROGRAMMES 

GRADE LEVELS SUBJECTS/COURSES 

Grades 7 and 8 

1. English 

2. Mathematics 

3. Personal Development  

4. Social Science 

5. Science 

6. Making a Living 

Grades 9 and 10 

1. English 

2. Mathematics 

3. Personal Development  

4. Science 

5. Social Science 

6. Business Studies 

7. Design and Technology- Computing 

Grades 11 and 12 

1. English – Applied English/Language& Literature  

2. Mathematics - Mathematics A / Mathematics B 

3. Science – Biology/Chemistry/Physics 

4. Social Science – History/Geography/Economics 

5. Personal Development 

6. Business Studies 

7. Information & Communication Technology 

 

 

 

 

GRADES 11 & 12 COURSE PROGRAMMES 

Notes: You must seek advice from your Provincial Coordinator regarding the recommended 

courses in each stream. Options should be discussed carefully before choosing the stream when 

enrolling into Grade 11.  FODE will certify for the successful completion of seven subjects in Grade 12. 

 

 

No Science Humanities Business 

1 Applied English Language & Literature Language & Literature/Applied English 

2 Mathematics A/B Mathematics A/B Mathematics A/B 

3 Personal Development Personal Development Personal Development 

4 Biology Biology/Physics/Chemistry Biology/Physics/Chemistry 

5 Chemistry/ Physics Geography Economics/Geography/History 

6 Geography/History/Economics History / Economics  Business Studies 

7 ICT ICT ICT   

CERTIFICATE IN MATRICULATION STUDIES 

No Compulsory Courses Optional Courses 

1 English 1 Science Stream: Biology, Chemistry, Physics    

2 English 2 Social Science Stream: Geography, Intro to Economics and Asia 
and the Modern World 

3 Mathematics 1  

4 Mathematics 2  

5 History of Science & Technology  

REMEMBER: 

 For Grades 7 and 8, you are required to do all six (6) subjects. 

 For Grades 9 and 10, you must complete five (5) subjects and one (1) optional to be certified. Business Studies 
and Design & Technology – Computing are optional.  

 For Grades 11 and 12, you are required to complete seven (7) out of thirteen (13) subjects to be certified. 
Your Provincial Coordinator or Supervisor will give you more information regarding each subject and course. 

 

REMEMBER: You must successfully complete 8 courses: 5 compulsory and 3 optional. 





 

 

FODE PROVINCIAL CENTRES CONTACTS 

PC 

NO. 

FODE PROVINCIAL 

CENTRE 

 

ADDRESS 

 

PHONE/FAX 

CUG 

PHONES 

 

CONTACT PERSON 

 

CUG 

PHONE 

1 DARU P. O. Box 68, Daru 6459033  72228146 The 

Coordinator 

Senior 

Clerk 

72229047 

2 KEREMA P. O. Box 86, Kerema 6481303  72228124 The 

Coordinator 

Senior 

Clerk 

72229049 

3 CENTRAL C/- FODE HQ 3419228 72228110 The 

Coordinator 

Senior 

Clerk 

72229050 

4 ALOTAU P. O. Box 822, Alotau 6411343 / 6419195 72228130 The 

Coordinator 

Senior 

Clerk 

72229051 

5 POPONDETTA P. O. Box 71, 

Popondetta 

6297160 / 6297678  72228138 The 

Coordinator 

Senior 

Clerk 

72229052 

6 MENDI P. O. Box 237, Mendi 5491264 / 

72895095 

72228142 The 

Coordinator 

Senior 

Clerk 

72229053 

7 GOROKA P. O. Box 990, Goroka 5322085 / 5322321 72228116 The 

Coordinator 

Senior 

Clerk 

72229054 

8 KUNDIAWA P. O. Box 95, Kundiawa 5351612  72228144 The 

Coordinator 

Senior 

Clerk 

72229056 

9 MT HAGEN P. O. Box 418, Mt. 

Hagen 

5421194 / 5423332 72228148 The 

Coordinator 

Senior 

Clerk 

72229057 

10 VANIMO P. O. Box 38, Vanimo 4571175 / 4571438 72228140 The 

Coordinator 

Senior 

Clerk 

72229060 

11 WEWAK P. O. Box 583, Wewak 4562231/ 4561114 72228122 The 

Coordinator 

Senior 

Clerk 

72229062 

12 MADANG P. O. Box 2071, 

Madang 

4222418 72228126 The 

Coordinator 

Senior 

Clerk 

72229063 

13 LAE P. O. Box 4969, Lae 4725508 / 4721162  72228132 The 

Coordinator 

Senior 

Clerk 

72229064 

14 KIMBE P. O. Box 328, Kimbe 9835110 72228150 The 

Coordinator 

Senior 

Clerk 

72229065 

15 RABAUL P. O. Box 83, Kokopo 9400314  72228118 The 

Coordinator 

Senior 

Clerk 

72229067 

16 KAVIENG P. O. Box 284, Kavieng 9842183 72228136 The 

Coordinator 

Senior 

Clerk 

72229069 

17 BUKA P. O. Box 154, Buka 9739838 72228108 The 

Coordinator 

Senior 

Clerk 

72229073 

18 MANUS P. O. Box 41, Lorengau 9709251 72228128 The 

Coordinator 

Senior 

Clerk 

72229080 

19 NCD C/- FODE HQ 3230299 Ext 26 72228134 The 

Coordinator 

Senior 

Clerk 

72229081 

20 WABAG P. O. Box 259, Wabag 5471114  72228120 The 

Coordinator 

Senior 

Clerk 

72229082 

21 HELA P. O. Box 63, Tari 73197115 72228141 The 

Coordinator 

Senior 

Clerk 

72229083 

22 JIWAKA c/- FODE Hagen  72228143 The 

Coordinator 

Senior 

Clerk 

72229085 

 

 


